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How to Use this Book 

“Introduction to GeoGebra” covers all basics of the dynamic mathematics 
software GeoGebra. On the one hand, this book can serve as a basis for 
introductory workshops guided by an experienced GeoGebra presenter. On the 
other hand, you can use this document to learn the use of the software yourself.  
 
By working through this book you will learn about the use of GeoGebra for 
teaching and learning mathematics from middle school (age 10) up to college 
level. The provided sequence of activities introduces you to geometry tools, 
algebraic input, commands, and a selection of different GeoGebra features. 
Thereby, a variety of different mathematical topics is covered in order to 
familiarize you with the versatility of the software and to introduce you to some 
methods of integrating GeoGebra into your everyday teaching. 
 
We wish you a lot of fun and success working with GeoGebra! 
Judith, Markus, and the GeoGebra Team 
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1. Introduction and Installation of GeoGebra 

Background information about GeoGebra 

GeoGebra is dynamic mathematics software for schools that joins geometry, 
algebra and calculus. 
On the one hand, GeoGebra is an interactive geometry system. You can do 
constructions with points, vectors, segments, lines, polygons and conic sections 
as well as functions while changing them dynamically afterwards. 
On the other hand, equations and coordinates can be entered directly. Thus, 
GeoGebra has the ability to deal with variables for numbers, vectors and points. 
It finds derivatives and integrals of functions and offers commands like Root or 
Vertex. 

GeoGebra’s user interface  

After starting GeoGebra, the following window appears:   

 

Using the provided geometry tools in the Toolbar you can create geometric 
constructions on the Graphics View with your mouse. At the same time the 
corresponding coordinates and equations are displayed in the Algebra View. On 

the other hand, you can directly enter algebraic input, commands, and functions 
into the Input Bar by using the keyboard. While the graphical representation of all 
objects is displayed in the Graphics View, their algebraic numeric representation 
is shown in the Algebra View. In GeoGebra, geometry and algebra work side by 
side. 
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The user interface of GeoGebra is flexible and can be adapted to the needs of 
your students. If you want to use GeoGebra in early middle school, you might 
want to work with a blank sheet in the Graphics View and geometry tools. Later 
on, you might want to introduce the coordinate system using a grid to facilitate 
working with integer coordinates. In high school, you might want to use algebraic 
input in order to guide your students through algebra on into calculus. 
 
Apart from the Graphics and Algebra View, GeoGebra also offers a Spreadsheet 
View, a Computer Algebra (CAS) View, as well as a second Graphics View. 
These different views can be shown or hidden using the View menu. For quick 
access to several predefined user interface configuration, you may want to try the 
Perspectives Sidebar by clicking the bar to the right of the Graphics View. 
  

 
 
 
 
  

CAS View 
 

Spreadsheet 
View 

 

2nd Graphics 
View 
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Installing GeoGebra 

Preparations 

Create a new folder called GeoGebra_Introduction on your desktop. 
Hint: During the workshop, save all files into this folder so they are easy to find 
later on. 

GeoGebra Installers 

 Download the installer file from www.geogebra.org/download into the 
created GeoGebra_Introduction folder on your computer.  
Hint: Make sure you have the correct version for your operating system.  

 Double-click the GeoGebra installer file and follow the instructions of the 
installer assistant. 

 

 
 

http://www.geogebra.org/download
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2. Basic Use of GeoGebra 

How to operate GeoGebra’s geometry tools 

 Activate a tool by clicking on the button showing the corresponding icon. 

 Open a toolbox by clicking on the lower part of a button and select another 
tool from this toolbox.  
Hint: You don’t have to open the toolbox every time you want to select a 
tool. If the icon of the desired tool is already shown on the button it can be 
activated directly.   
Hint: Toolboxes contain similar tools or tools that generate the same type 
of new object. 

 Click on the  icon at the right of the Toolbar to get help on the currently 
active tool. 

How to save and open GeoGebra files 

Saving GeoGebra Files 

 Open the File menu and select  Save. 

 Select the folder GeoGebra_Introduction in the appearing dialog window. 

 Type in a name for your GeoGebra file. 

 Click Save in order to finish this process. 
 
Hint: A file with the extension ‘.ggb’ is created. This extension identifies 
GeoGebra files and indicates that they can only be opened with GeoGebra. 
 
Hint: Name your files properly: Avoid using spaces or special symbols in a file 
name since they can cause unnecessary problems when transferred to other 
computers. Instead you can use underscores or upper case letters within the file 
name (e.g. First_Drawing.ggb). 

Opening GeoGebra Files 

 Open a new GeoGebra window (menu File –  New window). 

 Open a blank GeoGebra interface within the same window (menu File – 
New). 

 Open an already existing GeoGebra file (menu File –  Open). 
o Navigate through the folder structure in the appearing window. 
o Select a GeoGebra file (extension ‘.ggb’) and click Open. 

Hint: If you didn’t save the existing construction yet GeoGebra will ask you to do 
so before the blank screen / new file is opened. 
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3. Creating drawings with GeoGebra 

Preparations 

 Click on the arrow at the right side of the Graphics View and select 

 Basic Geometry from the Perspectives Sidebar. 

 Right-click (MacOS: Ctrl-click) on the Graphics View and choose  Grid 
to show the grid lines 

 

 

Drawing Pictures with GeoGebra 

Use the mouse and the following selection of tools in order to draw figures in the 
Graphics View (e.g. square, rectangle, house, tree,…). 
 

 
Point     New! 
Hint: Click on the Graphics View or an already existing object to create a new point. 

 
Move     New! 
Hint: Drag a free object with the mouse. 

 
Line      New! 
Hint: Click on the Graphics View twice or on two already existing points. 

 
Segment    New! 
Hint: Click on the Graphics View twice or on two already existing points. 

 
Delete     New! 
Hint: Click on an object to delete it. 

 
Undo / Redo    New! 
Hint: Undo / redo a construction step by step (on the right side of the Toolbar). 

 
Move Graphics View   New! 
Hint: Click and drag the Graphics View to change the visible part. 

 
Zoom In / Zoom Out   New! 
Hint: Click on the Graphics View to zoom in / out. 

 
Hint: Move the mouse over a tool to show a tooltip on how to use the tool.  
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What to practice  

 How to select an already existing object.   
Hint: When the pointer hovers above an object it highlights and the pointer 
changes its shape from a cross to an arrow. Clicking selects the 
corresponding object. 

 How to create a point that lies on an object.  
Hint: The point is displayed in a light blue color. Always check if the point 
really lies on the object by dragging it with the mouse (Move tool). 

 How to correct mistakes step-by-step using the Undo and Redo buttons. 
 
Note: Several tools allow the creation of points “on the fly”. This means that no 
existing objects are required in order to use the tool. 
Example: The tool Segment can be applied to two already existing points or to 
the empty Graphics View. By clicking on the Graphics View the corresponding 
points are created and a segment is drawn in between them. 

4. Drawings, Constructions, and Drag Test  

Open the link to the dynamic worksheet “Squares, Squares, Squares,…” 
http://www.geogebratube.org/student/m25902. 

 
The dynamic figure shows several squares 
constructed in different ways.  

 Examine the squares by dragging ALL 
their vertices with the mouse. 

 Find out which of the quadrilaterals are 
real squares and which ones just 
happen to look like squares. 

 Try to come up with a conjecture about 
how each square was created. 

 Write down your conjectures on paper. 
 

Discussion 

 What is the difference between a drawing and a construction? 

 What is the “drag test” and why is it important? 

 Why is it important to construct figures instead of just drawing them in 
interactive geometry software?  

 What do we have to know about the geometric figure before we are able 
to construct it using dynamic mathematics software? 

http://www.geogebratube.org/student/m25902
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5. Rectangle Construction        

Preparations 

 Summarize the properties of a rectangle 
before you start the construction.  
Hint: If you don’t know the construction 
steps necessary for a rectangle you 
might want to open the link to the 
dynamic worksheet “Rectangle 
Construction” 
http://www.geogebratube.org/student/m
25907. Use the buttons of the Navigation Bar in order to replay the 
construction steps.  

 Open a new GeoGebra window. 

 Switch to Perspectives -  Basic Geometry. 

 Change the labeling setting to New Points Only (menu Options – 
Labeling). 

Introduction of new tools 

 

Perpendicular Line  New! 
Hint: Click on an already existing line and a point in order to create a perpendicular line 
through this point. 

 

Parallel Line   New! 
Hint: Click on an already existing line and a point in order to create a parallel line 
through this point. 

 

Intersect   New! 
Hint: Click on the intersection point of two objects to get this one intersection point. 
Successively click on both objects to get all intersection points. 

 

Polygon   New! 
Hints: Click on the Graphics View or already existing points in order to create the 
vertices of a polygon. Connect the last and first vertex to close the polygon! Always 
connect vertices counterclockwise! 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use a tool. 
Try out all new tools before you start the construction. 

Construction Steps 

1 
 

Create segment AB. 

2 
 

Create a perpendicular line to segment AB through point B. 

http://www.geogebratube.org/student/m25907
http://www.geogebratube.org/student/m25907
https://www.youtube.com/watch?v=t3-QM2daH0o&list=PLITakOESY-2x__60pK3d1E4mQt2NJLGgo&index=2
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3 
 

Insert a new point C on the perpendicular line. 

4 
 

Construct a parallel line to segment AB through point C. 

5 
 

Create a perpendicular line to segment AB through point A. 

6 
 

Construct intersection point D. 

7 
 

Create the polygon ABCD. 

  Hint: To close the polygon click on the first vertex again. 

8  Save the construction. 

9 
 

Apply the drag test to check if the construction is correct. 

6. Navigation Bar and Construction Protocol   

Right-click (MacOS: Ctrl-click) the Graphics View to show the Navigation Bar to 
review your construction step-by-step using its buttons.  

 

In addition, you can open the  Construction Protocol (View menu) to get 
detailed information about your construction steps. 

What to practice 

 Try to change the order of some construction steps by dragging a line with the 
mouse. Why does this NOT always work? 

 Group several constructions steps by setting breakpoints: 
o Show the column Breakpoint by 

checking Breakpoint in the  

 Column drop-down menu  
o Group construction steps by 

checking the Breakpoint box of the 
last one of the group. 

o Change setting to Show Only 

Breakpoints in the  Options 
drop-down menu  

o Use the Navigation Bar to review 
the construction step-by-step. Did 
you set the breakpoints correctly? 
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7. Equilateral Triangle Construction      

Preparations 

 Summarize the properties of an equilateral 
triangle before you start the construction.  
Hint: If you don’t know the construction steps 
necessary for an equilateral triangle you might 
want to have a look at the following link to the 
dynamic worksheet “Equilateral Triangle 
Construction” 
http://www.geogebratube.org/student/m25909. 
Use the buttons of the Navigation Bar in order to replay the construction 
steps.  

 Open a new GeoGebra window. 

 Switch to Perspectives -  Geometry. 

 Change the labeling setting to New Points Only (menu Options – 
Labeling). 

Introduction of new tools 

 

Circle with Center through Point New! 
Hint: First click creates center, second click determines radius of the circle. 

 

Show / Hide Object   New! 
Hints: Highlight all objects that should be hidden, then switch to another tool in order to 
apply the visibility changes! 

 

Angle      New! 
Hint: Click on the points in counterclockwise direction! GeoGebra always creates angles 
with mathematically positive orientation. 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use a tool. 
Try out all new tools before you start the construction. 

Construction Steps 

1 
 

Create segment AB. 

2 
 

Construct a circle with center A through B. 

  
Hint: Drag points A and B to check if the circle is connected to 
them. 

3 
 

Construct a circle with center B through A. 

4 
 

Intersect both circles to get point C. 

http://www.geogebratube.org/student/m25909
https://www.youtube.com/watch?v=LCQPeMsC5_Y&index=2&list=PLITakOESY-2x__60pK3d1E4mQt2NJLGgo
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5 
 

Create the polygon ABC in counterclockwise direction. 

6 
 

Hide the two circles. 

7 
 

Show the interior angles of the triangle by clicking somewhere 
inside the triangle. 

  
Hint: Clockwise creation of the polygon gives you the exterior 
angles! 

8  Save the construction. 

9 
 

Apply the drag test to check if the construction is correct. 

8. GeoGebra’s Object Properties 

Graphics View Stylebar 

You can find a  button showing a small arrow to toggle the Stylebar in the 
upper left corner of the Graphics View. Depending on the currently selected tool 
or objects, the Stylebar shows different options to change the color, size, and 
style of objects in your construction. In the screenshot below, you see options 
to show or hide the axes and the grid, adapt point capturing, set the color, point 
style, etc. 
 

 
 
Hint: Each view has its own Stylebar. To toggle it, just click on the arrow in the 
upper left corner of the view. 

Object Preferences Dialog 

For more object properties you can use the Preferences dialog. You can access 
it in different ways: 

 Click on the symbol  on the right side of the Toolbar. Then choose 
Objects from the appearing menu. 

 Right-click (MacOS: Ctrl-click) an object and select  Object 
Properties... 

 In the Edit menu at the top select Object Properties…  

 Select the  Move tool and double-click on an object in the Graphics 
View. In the appearing Redefine dialog, click on the button Object 
Properties. 

http://wiki.geogebra.org/en/Options_Menu#Point_capturing
http://wiki.geogebra.org/en/File:Tool_Move.gif
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What to practice 

 Select different objects from the list on the left hand side and explore the 
available properties tabs for different types of objects.  

 Select several objects in order to change a certain property for all of them 
at the same time.   
Hint: Hold the Ctrl-key (MacOS: Cmd-key) pressed and select all desired 
objects.  

 Select all objects of one type by clicking on the corresponding heading. 

 Show the value of different objects and try out different label styles. 

 Change the default properties of certain objects (e.g. color, style,…). 
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9. Challenge of the Day: Isosceles Triangle Construction 

Construct an isosceles triangle whose length of the base and height can be 
modified by dragging corresponding vertices with the mouse.  
You will need the following tools in order to solve this challenge: 
 

 
Segment 

 
Point 

 
Midpoint or Center   New! 

 
Polygon 

 
Perpendicular Line 

 
Move  

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use a tool. 
Try out all new tools before you start the construction. 

 

Tips and Tricks 

 Summarize the properties of the geometric figure you want to create. 

 Try to find out which GeoGebra tools can be used in order to construct the 
figure using some of these properties (e.g. right angle – tool Perpendicular 
Line).  

 Make sure, you know how to use each tool before you begin the 
construction. If you don’t know how to operate a certain tool, activate it 
and read the Toolbar help. 

 For the activity open a new GeoGebra window and switch to Perspectives 
- Geometry. 

 You might want to save your files before you start a new activity. 

 Don’t forget about the Undo and Redo buttons in case you make a 
mistake. 

 Frequently use the Move tool in order to check your construction (e.g. are 
objects really connected, did you create any unnecessary objects). 

 If you have questions, please ask a colleague before you address the 
presenter or assistant(s). 
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1. Square Construction         

In this section you are going to use the following tools. Make sure you know how 
to use each tool before you begin with the actual construction of the square: 
 

 
Segment  

 
Polygon 

 
Perpendicular Line  

 
Show / Hide Object 

 
Circle with Center through Point  

 
Move 

 
Intersect     

Hint: You might want to have a look at the link to the dynamic worksheet “Square 
Construction” http://www.geogebratube.org/student/m25910 if you are not sure 
about the construction steps. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Change the labeling setting to New  
Points Only (menu Options – Labeling). 

Construction Steps 

1 
 

Draw the segment a = AB between points A and B. 

2 
 

Construct a perpendicular line b to segment AB through point B. 

3 
 

Construct a circle c with center B through point A. 

4 
 

Intersect the perpendicular line b with the circle c to get the 
intersection points C and D. 

5 
 

Construct a perpendicular line d to segment AB through point A. 

6 
 

Construct a circle e with center A through point B. 

7 
 

Intersect the perpendicular line d with the circle e to get the 
intersection points E and F. 

8 
 

Create the polygon ABCE. 

  
Hint: Don’t forget to close the polygon by clicking on point A after 
selecting point E. 

http://www.geogebratube.org/student/m25910
https://www.youtube.com/watch?v=qifsRZmNK4I&index=2&list=PLITakOESY-2w609dPA2_ffJTK5uoeE-28


 

Introduction to GeoGebra   
 

 

 22   

9 
 

Hide circles and perpendicular lines. 

10 
 

Perform the drag test to check if your construction is correct. 

11  Enhance your construction using the Stylebar.  

 
Challenge: Can you come up with a different way of constructing a square? 
 

Hint: To rename an object quickly, click on it in  Move mode and start typing 
the new name on the keyboard to open the Rename dialog.  

 

2. Regular Hexagon Construction      

In this section you are going to use the following tools. Make sure you know how 
to use each tool before you begin with the actual construction of the hexagon: 
 

 
Circle with Center through Point  

 
Angle 

 
Intersect  

 
Show / Hide Object 

 
Polygon  

 
Move 

 
Hint: You might want to have a look at the link to the dynamic worksheet 
“Regular Hexagon Construction” http://www.geogebratube.org/student/m25912 if 
you are not sure about the construction steps. 

Preparations  

 Open a new GeoGebra window. 

 Switch to Perspectives –  

 Geometry. 

 Change the labeling setting to All New 
Objects (menu Options – Labeling). 

http://www.geogebratube.org/student/m25912
https://www.youtube.com/watch?v=yLCead7g3Do&index=2&list=PLITakOESY-2w609dPA2_ffJTK5uoeE-28
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Construction Steps 

1 
 

Draw a circle c with center A through point B. 

2 
 

Construct a new circle d with center B through point A. 

3 
 

Intersect the circles c and d to get the hexagon’s vertices C and D. 

4 
 

Construct a new circle e with center C through point A. 

5 
 

Intersect the new circle e with circle c in order to get vertex E. 

  
Hint: Selecting circle e and circle c creates both intersection points. If 
you just want a single intersection point, click on the intersection of 
the two circles directly. 

6 
 

Construct a new circle f with center D through point A. 

7 
 

Intersect the new circle f with circle c in order to get vertex F. 

8 
 

Construct a new circle g with center E through point A. 

9 
 

Intersect the new circle g with circle c in order to get vertex G. 

10 
 

Draw hexagon FGECBD. 

11 
 

Hide the circles. 

12 
 

Display the interior angles of the hexagon. 

13 
 

Perform the drag test to check if your construction is correct. 

 
Challenge: Try to find an explanation for this construction process.  
Hint: Which radius do the circles have and why? 

3. Circumcircle of a Triangle Construction     

In this section you are going to use the following tools. Make sure you know how 
to use each tool before you begin with the actual construction: 
 

 
Polygon 

 

 

Circle With Center through 
Point 

 
Perpendicular Bisector  New!  

 
Move 

 
Intersect    

 

https://www.youtube.com/watch?v=s9dgGmZyrkU&list=PLITakOESY-2w609dPA2_ffJTK5uoeE-28&index=3
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Hint: If you are not sure about the construction steps, you might want to have a 
look at the link to the dynamic worksheet “Circumcircle of a Triangle 
Construction” http://www.geogebratube.org/student/m25916. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Change the labeling setting to New Points 
Only (menu Options – Labeling). 

Introduction of new tool 

 
Perpendicular Bisector New! 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use the tool.  
Try out the new tool before you start the construction. 

Construction Steps 

1 
 

Create an arbitrary triangle ABC. 

2 
 

Construct the perpendicular bisector for each side of the triangle. 

  
Hint: The tool Perpendicular Bisector can be applied to an existing 
segment. 

3 
 

Create intersection point D of two of the line bisectors. 

  

Hint: The tool Intersect can’t be applied to the intersection of three 
lines. Either select two of the three line bisectors successively, or 
click on the intersection point and select one line at a time from the 
appearing list of objects in this position. 

4 
 

Construct a circle with center D through one of the vertices of triangle 
ABC. 

5 
 

Perform the drag test to check if your construction is correct. 

Back to school…  

Modify your construction to answer the following questions: 
1. Can the circumcenter of a triangle lie outside the triangle? If yes, for which 

types of triangles is this true? 
2. Try to find an explanation for using line bisectors in order to create the 

circumcenter of a triangle. 

http://www.geogebratube.org/student/m25916
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4. Visualize the Theorem of Thales      

Back to school… 

Before you begin this construction, check out the link 
to the dynamic worksheet called “Theorem of Thales” 
http://www.geogebratube.org/student/m25919 in order 
to see how students could rediscover what the Greek philosopher and 
mathematician Thales found out about 2600 years ago.  
 
In this activity you are going to use the following tools. Make sure you know how 
to use each tool before you begin with the actual construction: 
 

 
Segment  

 
Polygon 

 
Semicircle through 2 Points New!  

 
Angle 

 
Point  

 
Move 

 

Hint: If you are not sure about the construction steps, you might want to have a 
look at the link to the dynamic worksheet “Theorem of Thales Construction” 
http://www.geogebratube.org/student/m27291. 
 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Change the labeling setting to New Points Only (menu Options – 
Labeling). 
 

Introduction of a new tool 

 

Semicircle through 2 Points    New! 
Hint: The order of clicking points A and B determines the direction of the semicircle. 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use the tool. 
Try out the new tool before you start the construction. 

http://www.geogebratube.org/student/m25919
http://www.geogebratube.org/student/m27291
https://www.youtube.com/watch?v=0gRPyOuS3Yg&list=PLITakOESY-2w609dPA2_ffJTK5uoeE-28&index=4
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Construction Steps 

1 
 

Draw a segment AB. 

2 
 

Construct a semicircle through points A and B. 

3 
 

Create a new point C on the semicircle. 

 
 

Hint: Check if point C really lies on the arc by dragging it with the 
mouse. 

4 
 

Create the triangle ABC in counterclockwise direction. 

5 
 

Create the interior angles of triangle ABC. 

  Hint: Click in the middle of the polygon. 

6 
 

Drag point C to check if your construction is correct. 

 
Challenge: Try to come up with a graphical proof for this theorem. 
Hint: Create midpoint O of segment AB and display the radius OC as a segment. 

5. Constructing Tangents to a Circle      

Back to school… 

Open the link to dynamic worksheet called  “Constructing Tangents to a Circle“ 
http://www.geogebra.org/book/intro-en/worksheets/Tangents_Circle.html. Follow 
the directions on the worksheet in order to find out how to construct tangents to a 
circle. 

http://www.geogebra.org/book/intro-en/worksheets/Tangents_Circle.html
https://www.youtube.com/watch?v=eJMApJR9qeY&index=5&list=PLITakOESY-2w609dPA2_ffJTK5uoeE-28
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Discussion 

 Which tools did you use in order to recreate the construction?  

 Were there any new tools involved in the suggested construction steps? If 
yes, how did you find out how to operate the new tool?  

 Did you notice anything about the Toolbar displayed in the right applet?  

 Do you think your students could work with such a dynamic worksheet and 
find out about construction steps on their own? 

What if your mouse and touchpad wouldn’t work? 

Imagine your mouse and / or touchpad stop working while you are preparing 
GeoGebra files for tomorrow’s lesson. How can you finish the construction file? 
 
GeoGebra offers algebraic input and commands in addition to the geometry 
tools. Every tool has a matching command and therefore, could be applied 
without even using the mouse. 
Note: GeoGebra offers more commands than geometry tools. Therefore, not 
every command has a corresponding geometry tool! 

Task 

Open the  Input Help dialog next to the Input Bar to get the list of commands 
and look for commands whose corresponding tools were already introduced in 
this workshop. 
 
As you saw in the last activity, the construction of tangents to a circle can be 
done by using geometric construction tools only. You will now recreate this 
construction by just using keyboard input. 

Preparations 

 Open a new GeoGebra 
window. 

 Switch to Perspectives  

 Algebra & Graphics. 
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Construction Steps 

1 A = (0,0) Create point A. 

  Hint: The parentheses are closed automatically. 

2 (3,0) Create point B. 

  
Hint: If you don’t specify a name objects are named in 
alphabetical order. 

3 Circle[A,B] Construct a circle c with center A through point B  

  Hint: This circle is a dependent object. 

 
Note: GeoGebra distinguishes between free and dependent objects. While free 
objects can be directly modified either using the mouse or the keyboard, 
dependent objects adapt to changes of their parent objects. Thereby, it is 
irrelevant in which way (mouse or keyboard) an object was initially created! 

Task 1 

Activate  Move mode and double-click an object in the Algebra View in order to 
change its algebraic representation using the keyboard. Hit the Enter key once 
you are done. 

Task 2 

Use the arrow keys in order to move free objects in a more controlled way. 

Activate  Move mode and select an object (e.g. a free point) in either window. 
Press the up / down or left / right arrow keys in order to move the object into the 
desired direction. 

4 C = (5, 4) Create point C. 

5 s = Segment[A, C] Create segment AC. 

6 D = Midpoint[s] Create midpoint D of segment AC. 

7 d = Circle[D, C] 
Construct a circle d with center D through point 
C. 

8 Intersect[c, d] 
Create intersection points E and F of the two 
circles c and d. 

9 Line[C, E] Create a tangent through points C and E. 

10 Line[C, F] Create a tangent through points C and F. 
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Checking and enhancing the construction 

 Perform the drag-test in order to check if the construction is correct. 

 Change the properties of the objects in order to improve the construction’s 
appearance (e.g. colors, line thickness, auxiliary objects dashed,…). 

 Save the construction. 

Discussion 

 Did any problems or difficulties occur during the construction steps? 

 Which version of the construction (mouse or keyboard) do you prefer and 
why? 

 Why should we use the keyboard for the input if we could also do it using 
tools?  
Hint: There are commands available that have no equivalent geometric 
tool. 

 Does it matter in which way an object was created? Can it be changed in 
the Algebra View (using the keyboard) as well as in the Graphics View 
(using the mouse)? 

6. Exploring Parameters of a Quadratic Polynomial   

Back to school…           

In this activity you will explore the impact of parameters on a quadratic 
polynomial. You will experience how GeoGebra could be integrated into a 
‘traditional’ teaching environment and used for active and student-centered 
learning. 
 
Follow the construction steps of this activity and write down your results and 
observations while working with GeoGebra. Your notes will help you during the 
following discussion of this activity. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Algebra & Graphics. 

Construction Steps 

1  Type f(x) = x^2 into the Input Bar and hit the Enter key. 

  Task: Which shape does the function graph have? 

2 
 

Click on the polynomial in the Algebra View. 

https://www.youtube.com/watch?v=T_S_JhvvMCk&index=6&list=PLITakOESY-2w609dPA2_ffJTK5uoeE-28


 

Introduction to GeoGebra   
 

 

 30   

3 ↑   ↓ Use the ↑ up and ↓ down arrow keys. 

  
Task: How does this impact the graph and the equation of the 
polynomial? 

4 
 

Again click on the polynomial in the Algebra View. 

5 
←  
→ 

Use the ← left and → right arrow keys. 

  
Task: How does this impact the graph and the equation of the 
polynomial? 

6 
 

Double-click the equation of the polynomial. Use the keyboard to 

change the equation to f(x) = 3 x^2. 

  
Task: How does the function graph change? 
Repeat changing the equation by typing in different values for the 
parameter (e.g. 0.5, -2, -0.8, 3). 

Discussion 

 Did any problems or difficulties concerning the use of GeoGebra occur? 

 How can a setting like this (GeoGebra in combination with instructions on 
paper) be integrated into a ‘traditional’ teaching environment? 

 Do you think it is possible to give such an activity as a homework problem 
to your students? 

 In which way could the dynamic exploration of parameters of a polynomial 
possibly affect your students’ learning? 

 Do you have ideas for other mathematical topics that could be taught in 
similar learning environment (paper worksheets in combination with 
computers)? 

7. Using Sliders to Modify Parameters      

Let’s try out a more dynamic way of exploring the impact of a parameter on a 

polynomial f(x) = a * x^2 by using sliders to modify the parameter values. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Algebra & Graphics. 

Construction Steps 

1  Create a variable a = 1. 

https://www.youtube.com/watch?v=DuRaA3Kf6NU&index=7&list=PLITakOESY-2w609dPA2_ffJTK5uoeE-28
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2  Display the variable a as a slider in the Graphics View. 

  
Hint: Click on the symbol  next to number a in the Algebra View. 
Change the slider value by dragging the appearing point on the line 
with the mouse. 

3  Enter the quadratic polynomial f(x) = a * x^2. 

  Hint: Don’t forget to enter an asterisk * or space between a and x^2. 

4 
 

Create a slider b using the Slider tool 

  
Hint: Activate the tool and click on the Graphics View. Use the 
default settings and click Apply. 

5  Enter the polynomial f(x) = a * x^2 + b. 

  
Hint: GeoGebra will overwrite the old function f with the new 
definition. 

Tips and Tricks 

 Name a new object by typing in name = into the Input Bar in front of its 

algebraic representation. 

Example: P = (3, 2) creates point P. 

 Multiplication needs to be entered using an asterisk or space between 
the factors. 

Example: a*x or a x 

 GeoGebra is case sensitive! Thus, upper and lower case letters must 
not be mixed up.  
Note: 

o Points are always named with upper case letters.  

Example: A = (1, 2) 

o Vectors are named with lower case letters. 

Example: v = (1, 3) 

o Segments, lines, circles, functions… are always named with lower 
case letters.  

Example: circle c: (x – 2)^2 + (y – 1)^2 = 16 

o The variable x within a function and the variables x and y in the 
equation of a conic section always need to be lower case.  

Example: f(x) = 3*x + 2 

 If you want to use an object within an algebraic expression or 
command you need to create the object prior to using its name in the Input 
Bar. 
Examples:  

o y = m x + b creates a line whose parameters are already 

existing values m and b (e.g. numbers / sliders). 

o Line[A, B] creates a line through existing points A and B. 
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 Confirm an expression you entered into the Input Bar by pressing the 
Enter key. 

 Open the GeoGebra Help dialog for using the Input Bar by clicking on 
the Input Bar and pressing F1.  

 Error messages: Always read the messages – they could possibly help to 
fix the problem! 

 Commands can be typed in or selected from the list  next to the Input Bar.  
Hint: If you need further information about a certain command, select  

 Help from the Help menu to open the GeoGebra Manual pages. There 
you can find detailed descriptions for all commands and tools.  

 Automatic completion of commands: After typing in the first two letters 
of a command into the Input Bar, GeoGebra tries to complete the 
command and shows you the required parameters within the brackets. 

o If GeoGebra suggests the desired command, hit the Enter key in 
order to place the cursor within the brackets.  

o If the suggested command is not the one you wanted to enter, just 
keep typing until the suggestion matches. 

8. Challenge of the Day: Parameters of Polynomials 

Use the file created in the last activity in order to work on the following tasks: 

 Change the parameter value a by moving the point on the slider with the 
mouse. How does this influence the graph of the polynomial? What 
happens to the graph when the parameter value is  

(a) greater than 1,  
(b) between 0 and 1, or  
(c) negative?  

Write down your observations. 

 Change the parameter value b. How does this influence the graph of the 
polynomial? 

 Create a slider for a new parameter c. Enter the quadratic polynomial 
f(x) = a * x^2 + b x + c. Change the parameter value c and find 

out how this influences the graph of the polynomial. 
 



 

 

 

 

 

 

Algebraic Input, Functions & 

Export of Pictures to the 

Clipboard 
 

GeoGebra Workshop Handout 3 
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1. Parameters of a Linear Equation      

In this activity you are going to use the following tools, algebraic input and 
commands. Make sure you know how to use them before you begin with the 
actual construction. 
 

 
Slider  

 
Intersect 

 a: y = m x + b  
 

Slope    New! 

 
Segment  

 
Move 

 Intersect[a, yAxis]  
 

Delete 

 
Hint: You might want to have a look at the link to the dynamic worksheet 
“Parameters of a linear equation” http://www.geogebratube.org/student/m25968 
first. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives -  Algebra & Graphics. 

Construction Step 1 

Enter: a: y = 0.8 x + 3.2  

Tasks 

 Move the line in the Algebra View using the arrow keys. Which parameter 
are you able to change in this way? 

 Move the line in the Graphics View with the mouse. Which transformation 
can you apply to the line in this way? 

Introduction of new tool 

 
Slope  New! 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use the tool. 
Try out the new tool before you start the construction. 

http://www.geogebratube.org/student/m25968
https://www.youtube.com/watch?v=Fl28fedlH3Q&list=PLITakOESY-2w_2Vwej8zFCUMBy1S3zKd2&index=2
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Construction Steps 2 

1 
 

Delete the line created in construction step 1. 

2 
 

Create sliders m and b using the default settings of sliders. 

3  Enter a: y = m x + b. 

4 
 

Create the intersection point A between the line a and the y-axis. 

  Hint: You can use the command Intersect[a, yAxis]. 

5 
 

Create a point B at the origin. 

6 
 

Create a segment between the points A and B. 

  
Hint: You might want to increase the line thickness make the segment 
visible on top of the y-axis. 

7 
 

Create the slope (triangle) of the line. 

8 
 

Hide unnecessary objects. 

  
Hint: Instead of using this tool, you can also click on the appropriate 

symbols  in the Algebra View as well. 

9  Enhance the appearance of your construction using the Stylebar. 

 
 

 
 

Task 

Write down instructions for your students that guide them through examining the 
influence of the equation’s parameters on the line by using the sliders. These 
instructions could be provided on paper along with the GeoGebra file. 
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2. Library of Functions – Visualizing Absolute Values  

Apart from polynomials there are different types of functions available in 
GeoGebra (e.g. trigonometric functions, absolute value function, exponential 
function). Functions are treated as objects and can be used in combination with 
geometric constructions. 
 
Note: Some of the functions available can be selected from the menu next to the 
Input Bar. Please find a complete list of functions supported by GeoGebra in the 
GeoGebra Wiki (http://wiki.geogebra.org/en/). 

Preparations 

 Open a new GeoGebra window.  

 Switch to Perspectives –  

 Algebra & Graphics. 
 

Construction Steps 

1  Enter the absolute value function f(x) = abs(x). 

2  Enter the constant function g(x) = 3. 

3 
 

Intersect both functions. 

  
Hint: You need to intersect the functions twice in order to get both 
intersection points. 

 
Hint: You might want to close the Algebra View and show the names and values 
as labels of the objects. 

Back to school… 

(a) Move the constant function with the mouse or using the arrow keys. What is 
the relation between the y-coordinate and the x-coordinate of each intersection 
point? 
(b) Move the absolute value function up and down either using the mouse or the 
arrow keys. In which way does the function’s equation change?  
(c) How could this construction be used in order to familiarize students with the 
concept of absolute value?  
Hint: The symmetry of the function graph indicates that there are usually two 
solutions for an absolute value problem. 

http://wiki.geogebra.org/en/
https://www.youtube.com/watch?v=9nZTuKa5Ewk&list=PLITakOESY-2w_2Vwej8zFCUMBy1S3zKd2&index=2


 

Introduction to GeoGebra   
 

 

 37   

3. Library of Functions – Superposition of Sine Waves  

Excursion into physics         

Sound waves can be mathematically represented as a combination of sine 
waves. Every musical tone is composed of several sine waves of form 

  

y(t) =  a sine(wt +j).  

 
The amplitude a influences the volume of the tone while the angular frequency ω 
determines the pitch of the tone. The parameter φ is called phase and indicates if 
the sound wave is shifted in time. 
 
If two sine waves interfere, superposition occurs. This means that the sine waves 
amplify or diminish each other. We can simulate this phenomenon with 
GeoGebra in order to examine special cases that also occur in nature.  

Preparations 

 Open a new GeoGebra window.  

 Switch to Perspectives –  Algebra & Graphics. 

Construction Steps 

1 
 

Create three sliders a_1, ω_1 and φ_1. 

  
Hints: a_1 produces an index. You can select the Greek letters from 

the menu  next to the text field Name in the Slider dialog window. 

2  Enter the sine function g(x)= a_1 sin(ω_1 x + φ_1). 

  
Hint: Again, you can select the Greek letters from a menu next to the 
text field Name. 

3 
 

Create three sliders a_2, ω_2 and φ_2. 

  Hint: Sliders can be moved when the Slider tool is activated. 

4  Enter another sine function h(x)= a_2 sin(ω_2 x + φ_2). 

5  Create the sum of both functions sum(x) = g(x) + h(x). 

6  Change the color of the three functions so they are easier to identify. 

https://www.youtube.com/watch?v=y5QiMnOVnP4&index=3&list=PLITakOESY-2w_2Vwej8zFCUMBy1S3zKd2
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Back to school… 

(a)  Examine the impact of 
the parameters on the graph 
of the sine functions by 
changing the values of the 
sliders. 
 
(b)  Set a1 = 1, ω1 = 1 and 
φ1 = 0. For which values of 
a2, ω2 and φ2 does the sum 
have maximal amplitude? 
Note: In this case the 
resulting tone has the maximal volume. 
 
(c)  For which values of a2, ω2, and φ2 do the two functions cancel each other? 
Note: In this case no tone can be heard any more.  

4. Introducing Derivatives – The Slope Function   

In this activity you are going to use the following tools, algebraic input, and 
commands. Make sure you know how to use them before you begin with the 
actual construction. 
 

 
f(x) = x^2/2 + 1  

 
S = (x(A), m) 

 
Point  

 
Segment 

 
Tangents     

 
Move 

 
m = Slope[t]  

 
 

 
Hint: You might want to have a look at the link to the dynamic worksheet 
“Introducing Derivatives - The Slope Function” 
http://www.geogebratube.org/student/m25969  first. 

Preparations 

 Open a new GeoGebra window.  

 Switch to Perspectives -  Algebra & Graphics. 

http://www.geogebratube.org/student/m25969
https://www.youtube.com/watch?v=bLORZCIrJL8&list=PLITakOESY-2w_2Vwej8zFCUMBy1S3zKd2&index=4
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Introduction of new tool 

 

Tangents  New! 
Hint: Click on a point on a function and then on the function itself. 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use the tool. 
Try out the new tool before you start the construction. 

Construction Steps 

1  Enter the polynomial f(x) = x^2/2 + 1. 

2 
 

Create a new point A on function f. 

  
Hint: Move point A to check if it is really restricted to the function 
graph. 

3 
 

Create tangent t to function f through point A. 

4  Create the slope of tangent t using: m = Slope[t]. 

5  Define point S: S = (x(A), m). 

  Hint: x(A) gives you the x-coordinate of point A. 

6 
 

Connect points A and S using a segment. 

Back to school… 

(a)  Move point A along the function 
graph and make a conjecture 
about the shape of the path of 
point S, which corresponds to 
the slope function. 

(b)  Turn on the trace of point S. 
Move point A to check your 
conjecture.   
Hint: Right-click point S 
(MacOS: Ctrl-click) and select 

 Trace on. 
(c)  Find the equation of the 

resulting slope function. Enter the function and move point A. If it is correct 
the trace of point S will match the graph. 

(d)  Change the equation of the initial polynomial f to produce a new problem. 
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5. Exploring Polynomials        

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  

 Algebra & Graphics. 

 

Construction Steps 

1  Enter the cubic polynomial f(x) = 0.5x3 + 2x2 + 0.2x – 1. 

2  Create the roots of polynomial f: R = Root[f] 

  
Hint: If there are more than one root GeoGebra will produce indices 

for their names if you type in R = (e.g. R1, R2, R3). 

3  Create the extrema of polynomial f: E = Extremum[f]. 

  
English UK: Create the turning points of polynomial f:  

E = TurningPoint[f]. 

4 
 

Create tangents to f in E1 and E2 . 

5  
Create the inflection point of polynomial f:  
I = InflectionPoint[f]. 

 
Hint: You might want to change properties of objects (e.g. color of points, style of 
the tangents, show name and value of the function). 

6. Exporting a Picture to the Clipboard      

GeoGebra’s Graphics View can be exported as a picture to your computer’s 
clipboard. Thus, they can be easily inserted into text processing or presentation 
documents allowing you to create appealing sketches for tests, quizzes, notes or 
mathematical games. 
 
GeoGebra will export the whole Graphics View into the clipboard. Thus, you 
need to make the GeoGebra window smaller in order to reduce unnecessary 
space on the drawing pad: 

 Move your figure (or the relevant section) to the upper left corner of the 

Graphics View using the  Move Graphics View tool (see left figure 
below).  

https://www.youtube.com/watch?v=3SSeAucQj0w&list=PLITakOESY-2w_2Vwej8zFCUMBy1S3zKd2&index=5
https://www.youtube.com/watch?v=4pbLs8HGDSY&list=PLITakOESY-2w_2Vwej8zFCUMBy1S3zKd2&index=6
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Hint: You might want to use tools  Zoom in and  Zoom out in order to 
prepare your figure for the export process. 

 Reduce the size of the GeoGebra window by dragging its lower right 
corner with the mouse (see right figure below).  
Hint: The pointer will change its shape when hovering above an edges or 
corner of the GeoGebra window. 

 

 

 

 
GeoGebra window before 

the size reduction 
 

GeoGebra window after 
the size reduction 

 
Use the File menu to export the Graphics View to the clipboard: 

 Export – Graphics View to Clipboard  
Hint: You could also use the key combination Ctrl – Shift – C (MacOS: 
Cmd – Shift – C). 

 Your figure is now stored in your computer’s clipboard and can be inserted 
into any word processing or presentation document. 
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7. Inserting Pictures into a Text Processing Document  

Inserting pictures from the clipboard to MS Word 

After exporting a figure from GeoGebra into your computer’s clipboard you 
can now paste it into a word processing document (e.g. MS Word). 

 Open a new text processing document. 

 From the Home menu select Paste. The picture is inserted at the position 
of the cursor.  
Hint: You can use the key combination Ctrl – V (MacOS: Cmd – V) 
instead. 

 

 

Reducing the size of pictures 

If necessary you can reduce the size of the picture in MS Word: 

 Double-click the inserted picture. 

 Change the height/width of the picture using the Size group on the right. 
 

 
 
Note: If you change the size of a picture, the scale is modified. If you want to 
maintain the scale (e.g. for your students to measure lengths) make sure the size 
of the picture is 100%. 
 
Note: If a picture is too big to fit on one page MS Word will reduce its size 
automatically and thus, change its scale. 

Inserting pictures from the clipboard to OO Writer 

 Open a new text processing document 

 From the Edit menu select Paste or use the key combination Ctrl – V 
(MacOS: Cmd – V). 

 

https://www.youtube.com/watch?v=f7KKo38RZ9g&index=7&list=PLITakOESY-2w_2Vwej8zFCUMBy1S3zKd2
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Reducing the size of pictures in OO Writer 

 Double-click the inserted picture. 

 Select the Type tab in the appearing Picture window. 

 Change width/height of the picture. 

 Click OK. 

8. Challenge of the Day: Creating Instructional Materials 

Pick a mathematical topic of your interest and create a worksheet / notes / quiz 
for your students.  

 Create a figure in GeoGebra and export it to the clipboard. 

 Insert the picture into a word processing document. 

 Add explanations / tasks / problems for your students. 
 



 

 

 

 

 

 

Transformations & Inserting 

Pictures into the Graphics 

View 
 

GeoGebra Workshop Handout 4 
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1. Creating a ‘Function Domino’ Game     

In this activity you are going to practice exporting function graphs to the clipboard 
and inserting them into a word processing document in order to create cards for 
a ‘Function Domino’ game. Make sure you know how to enter different types of 
functions before you begin with this activity. 
 

 
 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Algebra & Graphics. 

Construction Steps for GeoGebra 

1  
Enter an arbitrary function. 

Examples: e(x) = exp(x) or f(x) = sin(x) 

2 
 

Move the function graph into the upper left corner of the Graphics 
View. 

3  
Reduce the size of the GeoGebra window so it only shows the 
desired part of the Graphics View. 

4  
Export the Graphics View to the clipboard. 

Hint: Menu File – Export –  Graphics View to Clipboard. 

https://www.youtube.com/watch?v=8VYEPMtYFKg&list=PLITakOESY-2ySi8HW9-bUWioCubl6VbLm&index=2


 

Introduction to GeoGebra   
 

 

 46   

Construction Steps for MS Word 

1 Open a new word processing document (e.g. MS Word). 

2 
Create a table with 2 columns and several rows. 
Hint: Menu Insert – Table… 

3 
Highlight the entire table (all cells) and open the Table Properties dialog. 
Hint: right-click – Table Properties… 

4 Click on tab Row and specify the row height as 2 inches. 

5 Click on tab Column and set the preferred width of the columns to 2 inches. 

6 Click on tab Cell and set the vertical alignment to Center. 

7 Click the OK button. 

8 
Place the cursor in one of the table cells. Insert the function graph picture 
from the clipboard. 
Hint: Menu Home – Paste or key combination Ctrl – V (MacOS: Cmd – V). 

9 
Adjust the size of the picture if necessary. 
Hint: Double-click the picture to open the Format tab and click on Size and 
set the longer side (either width or height) to 1.9 inches. 

10 
Enter the equation of a different function into the cell next to the picture. 
Hint: You might want to use an equation editor. 

 
Repeat the steps in GeoGebra for a different function (e.g. trigonometric, 
logarithmic) and insert the new picture into MS Word in order to create another 
domino card. 
 
Hint: Make sure to put the equation and graph of each function on different 
domino cards. 

2. Creating a ‘Geometric Figures Memory’ Game   

In this activity you are going to practice exporting geometric figures to the 
clipboard and inserting them into a word processing document in order to create 
cards for a memory game with geometric figures. Make sure you know how to 
construct different geometric figures (e.g. quadrilaterals, triangles) before you 
begin with this activity. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

https://www.youtube.com/watch?v=x_MAQdZv9vU&index=2&list=PLITakOESY-2ySi8HW9-bUWioCubl6VbLm
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Construction Steps for GeoGebra 

1 Construct a geometric figure (e.g. isosceles triangle). 

2 Use the Stylebar to enhance your construction. 

3 
Move the figure into the upper left corner of the Graphics View and adjust 
the size of the GeoGebra window. 

4 
Export the Graphics View to the clipboard. 

Hint: Menu File – Export –  Graphics View to Clipboard. 

 
 

 
 

Construction Steps for MS Word 

1 Open a new word processing document (e.g. MS Word). 

2 
Create a table with 2 columns and several rows. 
Hint: Menu Insert – Table… 

3 
Highlight the entire table (all cells) and open the Table Properties dialog. 
Hint: right-click – Table Properties… 

4 Click on tab Row and specify the row height as 2 inches. 

5 Click on tab Column and set the preferred width of the columns to 2 inches. 

6 Click on tab Cell and set the vertical alignment to Center. 

7 Click the OK button. 

8 
Place the cursor in one of the table cells. Insert the picture of the geometric 
figure from the clipboard. 
Hint: Menu File – Paste or key combination Ctrl – V (MacOS: Cmd – V). 
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9 
Adjust the size of the picture if necessary. 
Hint: Double-click the picture to open the Format tab. Then click on Size 
and set the longer side of the picture to 1.9 inches. 

10 Enter the name of the geometric shape into another cell of the table. 

 
Repeat the steps in GeoGebra for a different geometric shape (e.g. 
parallelogram, circle, triangle) and insert the new picture into MS Word in order to 
create another memory card. 
 
Hint: Make sure to put the name and sketch of each geometric shape on one of 
the memory cards. 

3. Exploring Symmetry with GeoGebra     

Back to school… 

Open the link to the dynamic worksheet “Axes of Symmetry” 
http://www.geogebratube.org/student/m27273. Follow the directions on the 
worksheet and experience how your students could explore the axes of 
symmetry of a flower.  
Hint: You will learn how to create such dynamic worksheets later in this 
workshop. 
 
 

 

Discussion 

 How could your students benefit from this prepared construction? 

 Which tools were used in order to create the dynamic figure? 

http://www.geogebratube.org/student/m27273
https://www.youtube.com/watch?v=KUfSIEyybBs&index=3&list=PLITakOESY-2ySi8HW9-bUWioCubl6VbLm
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Preparations 

 Make sure you have the picture http://www.geogebra.org/book/intro-
en/worksheets/flower.jpg saved on your computer. 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

Introduction of new tools 

 
Show / Hide Label  New! 

 

Reflect about Line  New! 
Hint: Click the object to be mirrored and then click the line of reflection. 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use these 
tools. Try out the new tools before you start the construction. 

Construction Steps 

1 
 

Create a new point A. 

2 
 

Show the label of point A. 

  Hint: The label style can be set in the Stylebar as well. 

3 
 

Construct a line of reflection through two points. 

4 
 

Create mirror point A at line to get image A’. 

5 
 

Create a segment between point A and its image A’. 

6  Turn the Trace on for points A and A′. 

  
Hint: Right-click (MacOS: Ctrl-click) the point and select Trace on. 
Whenever point A is moved it leaves a trace in the Graphics View. 

7 
 

Move point A to draw a dynamic figure. 

8 
 

Insert the image you saved into the Graphics View. 

  
Hint: Click in the lower left corner of the Graphics View to insert the 
picture at this position. 

9 
 

Adjust the position of the inserted image. 

10  Set the image as Background Image (Properties dialog, tab Basic). 

11  Reduce the Opacity of the image (Properties dialog, tab Color). 

  
Hint: After specifying the picture as a background image you can’t 
select it in the Graphics View any more. 

http://www.geogebra.org/book/intro-en/worksheets/flower.jpg
http://www.geogebra.org/book/intro-en/worksheets/flower.jpg
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Hint: The  Trace on feature has some special characteristics:  

 The trace is a temporary phenomenon. Whenever the 
graphics are refreshed, the trace disappears. 

 The trace can’t be saved and isn’t shown in the Algebra 
View. 

 To delete the trace you need to refresh the views (menu 
View – Refresh Views or key combination Ctrl – F. 
MacOS: Cmd – F). 

4. Resizing, Reflecting and Distorting a Picture 

In this activity you will to learn how to resize an inserted picture to a certain size 
and how to apply transformations to the picture in GeoGebra. 

Preparations 

 Make sure you have the picture from 
http://www.geogebra.org/book/intro-
en/worksheets/Sunset_Palmtrees.jpg saved 
on your computer. 

 Open a new GeoGebra window.  

 Switch to Perspectives –  Geometry and 
show the Input Bar (View menu – Input Bar). 

Construction Steps for reflecting and resizing a picture    

1 
 

Insert picture you saved on the left part of the Graphics View. 

2 
 

Create a new point A at the lower left corner of the picture. 

3  Set the point A as the FIRST corner point of your picture. 

  
Hint: Open the Properties dialog and select the picture in the list of 
objects. Click on tab Position and select point A from the drop-down 
list next to Corner 1. 

4  Create a new point B = A + (3, 0). 

5  Set the point B as the SECOND corner point of the picture. 

  Hint: You just changed the width of the picture to 3 cm. 

6 
 

Create a line through two points in the middle of the Graphics View. 

7 
 

Mirror the picture at the line. 

  
Hint: You might want to reduce the opacity of the image in order to 
be able to better distinguish it from the original (Properties dialog). 

http://www.geogebra.org/book/intro-en/worksheets/Sunset_Palmtrees.jpg
http://www.geogebra.org/book/intro-en/worksheets/Sunset_Palmtrees.jpg
https://www.youtube.com/watch?v=CliqjfWFMlU&list=PLITakOESY-2ySi8HW9-bUWioCubl6VbLm&index=4
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Back to school… 

(a) Move point A with the mouse. How does this affect the picture? 
 
(b) Move the picture with the mouse and observe how this affects its image. 
 
(c) Move the line of reflection by dragging the two points with the mouse. How  

does this affect the image? 

Construction Steps for distorting a picture       

1  Open the figure you created in the previous activity. 

2 
 

Delete the point B to restore the picture’s original size. 

3 
 

Create a new point B at the lower right corner of the original picture. 

4  Set the new point B as the SECOND corner point of your picture. 

  Hint: You can now resize the image by moving point B. 

5 
 

Create a new point E at the upper left corner of the original picture. 

  Hint: Type any letter to open the Rename dialog window.  

6  Set the new point E as the FOURTH corner point of your picture. 

Back to school… 

(a) How does moving point E affect the picture and 
its image? 
 
(b) Which geometric shape do the picture and the 
image form at any time? 

https://www.youtube.com/watch?v=S9xQjhbYW7A&index=5&list=PLITakOESY-2ySi8HW9-bUWioCubl6VbLm
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5. Exploring Properties of Reflection      

In this activity you will create a dynamic figure that allows your students to 
explore the properties of reflection. 

Preparations 

You will now modify the construction 
created in the previous activity. If you want 
to keep the original as well you need to 
save your file. 

Construction Steps 

1  
Open the file you created in the previous activity which contains the 
distorted picture of the palm trees and its reflection at a line. 

2 
 

Create a segment between points A and B. 

3 
 

Create a segment between points A and E. 

4 
 

Create a parallel line to segment AB through point E. 

5 
 

Create a parallel line to segment AE through point B. 

6 
 

Intersect the two lines to get intersection point F. 

7 
 

Hide auxiliary objects by unchecking the checkboxes. 

8 
 

Reflect all four corner points A, B, E and F at the line to get their 
images A’, B’, E’ and F’. 

9 
 

Connect corresponding points with segments (e.g. points A and A’). 

10 
 

Create angles between the line of reflection and the segments. 

Back to school… 

(a) Move the corner points A, B, E and F of the original picture. Are you able to 
drag all these points with the mouse? If no, which one can’t be dragged and 
why? 
(b) Move the line of reflection. What do you notice about the angles between the 
segments connecting the corresponding corner points and the line of reflection?  
(c) What can we call the line of reflection in relation to the segments formed by 
each point and its corresponding image? 

https://www.youtube.com/watch?v=MHaA9SuSgBI&list=PLITakOESY-2ySi8HW9-bUWioCubl6VbLm&index=6
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6. Translating Pictures         

In this activity you are going to use the following tools and commands. Make sure 
you know how to use each tool and command before you begin.  
 

 
Image  

 
Vector                                       New! 

 A = (1, 1)  
 

Translate by Vector                  New! 

 
Rigid Polygon             New!  

 
Move 

 Vector[O, P]  
 

Text 

Preparations 

 Make sure you have the picture from 
http://www.geogebra.org/book/intro-
en/worksheets/Bart.png saved on 
your computer. 

 Open a new GeoGebra window.  

 Switch to Perspectives –  Algebra 

& Graphics and show the  Grid (Stylebar).  

 Set the  Point Capturing to Fixed to Grid (Stylebar). 

Introduction of new tools 

 

Vector     New! 
Hint: First click determines the starting point and second click sets the vector’s endpoint. 

 

Translate by Vector   New! 
Hint: Click the object to be translated and then click the translation vector. 

 

Rigid Polygon                            New! 
Hint: Select all vertices, then click first vertex again. The resulting polygon will keep its 
shape when moved. It can be moved or rotated by dragging two vertices. 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use these 
tools. Try out the new tools before you start the construction. 

Construction Steps 

1 
 

Insert picture http://www.geogebra.org/book/intro-
en/worksheets/Bart.png into the first quadrant. 

2  Create points A = (1, 1), B = (3, 1) and D = (1, 4). 

http://www.geogebra.org/book/intro-en/worksheets/Bart.png
http://www.geogebra.org/book/intro-en/worksheets/Bart.png
http://www.geogebra.org/book/intro-en/worksheets/Bart.png
http://www.geogebra.org/book/intro-en/worksheets/Bart.png
https://www.youtube.com/watch?v=eWGApoK9rl4&index=7&list=PLITakOESY-2ySi8HW9-bUWioCubl6VbLm
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3  
Set point A as the FIRST, B as the SECOND and D as the 
FOURTH corner point of the picture. (Properties dialog - Position) 

4 
 

Create triangle ABD. 

5  Create points O = (0, 0) and P = (3, -2). 

6  Create vector u = Vector[O, P]. 

 
 

Hint: You could also use tool Vector. 

 7 
 

Translate the picture by vector u. 

  Hint: You might want to reduce the opacity of the image. 

8 
 

Translate the three corner points A, B and D by vector u. 

9 
 

Create triangle A’B’D’. 

10 
 

Hide point O so it can’t be moved accidentally.  

11  Change the color and size of objects to enhance your construction. 

7. Rotating Polygons        

In this activity you are going to use the following tools and commands. Make sure 
you know how to use each tool and command before you begin.  
 

 
Polygon  

 
Rotate around Point                                New! 

 
Point  

 
Segment 

 Rename               
 

Angle 

 
Slider  

 
Move 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry and show the  coordinate axes. 

 Click on  Preferences in the Toolbar and choose  Graphics to open 
the Properties dialog for the Graphics View. 

o On tab xAxis change the Distance to 1. 
o On tab yAxis change the Distance to 1. 

https://www.youtube.com/watch?v=rfy0W576ZKc&list=PLITakOESY-2ySi8HW9-bUWioCubl6VbLm&index=8
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Introduction of new tool 

 

Rotate around Point     New! 
Hint: Click the object to be rotated, the center of rotation and enter the angle in the 
appearing dialog window. 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use the tool. 
Try out the new tool before you start the construction. 

Construction Steps 

1 
 

Create an arbitrary triangle ABC in the second quadrant placing the 
vertices on grid points. 

2 
 

Create a new point D at the origin of the coordinate system. 

3  Rename the point D to O. 

  Hint: Just type “O” to open the Rename dialog.  

4 
 

Create a slider for angle α. 

  
Hint: In the Slider dialog window check Angle and set the Increment 
to 90˚. Make sure you don’t delete the ˚ symbol. 

5 
 

Rotate triangle ABC around point O by angle α. 

  Hint: Check counter clockwise rotation. 

6 
 

Create segments AO and A’O. 

7 
 

Create angle AOA’. 

  
Hint: Select the points in counter clockwise order. Hide the label of 
this angle. 

8 
 

Move slider and check the image of the triangle. 
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Enhancing the construction 

You will now learn how to ‘tidy up’ the Algebra View by defining some objects as 
Auxiliary objects and hiding their algebraic representation from view.  

 Show the Algebra View 

Hint: menu View –  Algebra. 

 Open the  Properties dialog for Objects.  

 Select all segments in the Properties dialog and check Auxiliary object on 
tab Basic.  
Hint: Click on the heading Segment in order to select all segments. 

 Repeat this step for the triangles, angles and point O at the origin.  
Hint: The Algebra View now only contains points A, B and C as well as 
their images A’, B’ and C’. 

 You can now show or hide the Auxiliary Objects by toggling the Auxiliary 
Objects button in Algebra Views Stylebar. 

 
 
 
Note: Your students can now check out the coordinates of the initial points and 
their images in the algebra window without being distracted by the algebraic 
representation of the other objects used in this construction. 

8. Challenge of the Day: Tiling with Regular Polygons 

Open the collection “Tilings” with a series of ten dynamic worksheets: 
http://www.geogebratube.org/student/c2660/m27274/ylyy. The first one of a 
series of ten dynamic worksheets that forms a learning environment to explore 
tiling with regular polygons opens. 
 
Hint: Use either the navigation left to the worksheet or the “Previous/Next in 
Collection”-button beneath the worksheet to navigate in this learning 
environment. 

Back to school… 

(a) Work through the tasks on the dynamic worksheets of this learning 
environment. Write down your answers on paper and discuss them with 
colleagues afterwards. 

 
(b) After working through the dynamic worksheets you should be able to answer 

the following questions: 

 Which regular polygons can be used to tile the plane?  

 Which transformation(s) did you use for the tiling?  

 How many of each of these polygons meet at one of their edges?  
 

http://www.geogebratube.org/student/c2660/m27274/ylyy
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(c) Fill in the missing values in the table below. Can you see any patterns? Try 
to find the formulas for an n-sided polygon. 

 

polygon parts polygon 

#  
vertices 

tiling possible 

yes / no 
# meet central angle interior angles interior angles 

3   --- ---  

4      

5      

6      

7      

… … … … … … 

n      

 
(d) Come up with a conjecture that helps you to reason why not every regular 

polygon can be used for tiling. 
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Tiling with regular polygons – worksheet solution 

 

polygon parts polygon 

# of 
vertices 

tiling 
possible 

yes / no 

# for 
tiling 

central angle interior angles interior angles 

3 yes 6 --- --- 60  

4 yes 4 90
4

360
=  45

2

90180
=

-
 90452 =×  

5 no --- 72
5

360
=  54

2

72180
=

-
 108542 =×  

6 yes 3 60
6

360
=  60

2

60180
=

-
 120602 =×  

7 no --- 
7

3
51

7

360
»  

7

2
64

2

7

3
51180

»

-

 7

4
128

7

2
642 =×  

… … … … … … 

n 

no 

for 

6>n  

--- 
n

360
 

2

180 360
n

-
 

n

360
180 -  

 
 



 

 

 

 

 

 

Inserting Static and Dynamic 

Text into the GeoGebra’s 

Graphics View 
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1. Coordinates of Reflected Points      

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Algebra & Graphics and show the  Grid. 

 In the Stylebar set the  Point capturing to Fixed to Grid. 

Construction Steps 

1 
 

Create point A = (3, 1). 

2  Create line a: y = 0. 

3 
 

Mirror point A at line a to get point A’. 

  Hint: You might want to match the color of line a and point A’. 

4  Create line b: x = 0. 

5 
 

Mirror point A at line b to get point A1’. 

  Hint: You might want to match the color of line b and point A1’. 

2. Inserting Text into the Graphics View     

Introduction of new tool 

 

Text    New! 
Hint: Click on the Graphics View to specify the location of your text. Enter the desired 
text into the appearing window and click OK. 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use a tool. 
Try out the new tool before you start the construction. 

Inserting static text 

Insert a heading into the Graphics View of GeoGebra so your students know 
what this dynamic figure is about: 

 Activate the  Text tool and click on the upper part of the Graphics View. 

https://www.youtube.com/watch?v=Q_luIBw9rcI&index=2&list=PLITakOESY-2yvF2sKHWJHxiP-Ph7unBHk
https://www.youtube.com/watch?v=hT5PKdrsfB0&index=2&list=PLITakOESY-2yvF2sKHWJHxiP-Ph7unBHk
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 Type the following text into the appearing window:   
Reflecting a point at the coordinate axes 

 Change the properties of the text using the Stylebar (e.g. wording, font 
style, font size, formatting). 

 Adjust the position of the text using the Move tool. 

 Fix the position of the text so it can’t be moved accidentally (Properties 
dialog – tab Basic – Fix object). 

Inserting dynamic text 

Dynamic text refers to existing objects and adapts 
automatically to modifications, for example in A = (3, 1) 
the coordinates change whenever point A is moved. 

 Activate the  Text tool and click on the 
Graphics View. 

 Type A = into the appearing window.  

Hint: This will be the static part of the text and 
won’t change if point A is moved. 

 Insert the dynamic part of this text by selecting 
point A from the Objects drop-down list. 

 Click OK. 

Enhancing the dynamic figure 

 Insert dynamic text that shows the coordinates of the reflected points A’ 
and A1’. 

 Zoom out in order to show a larger part of the coordinate plane.  
Hint: You might want to adjust the distance of the grid lines.  

o Open the  GeoGebra Properties dialog for the  Graphics 
View. 

o Select tab Grid. 
o Check the box next to Distance and change the values in both text 

fields to 1. 

 Close the Algebra View and fix all text so it can’t be moved accidentally.  
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Task 

Come up with instructions to guide your students towards discovering the relation 
between the coordinates of the original and the reflected points which could be 
provided along with the dynamic figure. 

3. Visualizing a System of Linear Equations    

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Algebra & Graphics and show the  Grid. 
 

 
 

Construction Steps 

1 
 

Create slider m_1 with the default settings for sliders. 

 
 

Hint: m_1 gives you m1. 

2 
 

Create slider b_1 with the default settings for sliders. 

3 
 

Create the linear equation line_1: y = m_1 x + b_1. 

4 
 

Create slider m_2 using the default settings for sliders. 

5 
 

Create slider b_2 using the default settings for sliders. 

6 
 

Create linear equation line_2: y = m_2 x + b_2. 

https://www.youtube.com/watch?v=feK0BX49HDk&list=PLITakOESY-2yvF2sKHWJHxiP-Ph7unBHk&index=3
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7 
 

Create the dynamic text1: Line 1: and select line_1 from Objects. 

8 
 

Create the dynamic text2: Line 2: and select line_2 from Objects. 

9 
 

Construct the intersection point A of both lines line1 and line2 . 

 
 Hint: You could use command Intersect[line_1, line_2] 

instead. 

10 
 

Define xcoordinate = x(A). 

 
 

Hint: x(A) gives you the x-coordinate of point A. 

11 
 

Define ycoordinate = y(A). 

 
 Hint: y(A) gives you the y-coordinate of point A. 

12  
Create the dynamic text3: Solution: x = and select xcoordinate 

from Objects. 

13 
 

Create the dynamic text4: y = and select ycoordinate from Objects. 

14 
 

Fix the text and sliders so they can’t be moved accidentally. 

Challenge 

Create a similar construction that allows for visualizing the graphical solution of a 
system of quadratic polynomials. 

Hint: Functions need to be entered using the syntax f(x) = … 

 
Note: Such a dynamic figure can also be used to visualize an equation in one 
variable by entering each side of the equation as one of the two functions. 

4. Visualizing the Angle Sum in a Triangle     

In this activity you are going to use the following tools. Make sure you know how 
to use each tool before you begin.  
 

 
Polygon  

 
Rotate around Point  

 
Angle  

 
Move 

 
Slider  

 
Text 

 
Midpoint    

https://www.youtube.com/watch?v=PttaaGTLJBA&list=PLITakOESY-2yvF2sKHWJHxiP-Ph7unBHk&index=4
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Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Show the Input Bar (View menu). 

 Set the number of decimal places to 0 (menu Options – Rounding). 

 

Introduction of new tool 

 

Midpoint or Center  New! 
Hint: Select two points, one segment, circle or conic to get the midpoint or center. 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use a tool. 
Try out the new tool before you start the construction. 

Construction Steps 

1 
 

Create a triangle ABC with counter clockwise orientation. 

2 
 

Create the angles α, β and γ of triangle ABC. 

3 
 

Create a slider for angle δ with Interval 0˚ to 180˚ and Increment 
10˚. 

4 
 

Create a slider for angle ε with Interval 0˚ to 180˚ and Increment 
10˚. 

5 
 

Create midpoint D of segment AC and midpoint E of segment AB. 

6 
 

Rotate the triangle around point D by angle δ (setting clockwise). 

7 
 

Rotate the triangle around point E by angle ε (setting 
counterclockwise). 

8 
 

Move both sliders δ and ε to show 180˚. 

9 
 

Create angle ζ using the points A’C’B’. 
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10 
 

Create angle η using the points C'1B'1A'1 . 

11  Enhance your construction using the Stylebar. 

  Hint: Congruent angles should have the same color. 

12 
 

Create dynamic text displaying the interior angles and their values 

(e.g. α =  and select α from Objects). 

13  Calculate the angle sum using sum = α + β + γ 

14 
 

Insert the angle sum as a dynamic text: α + β + γ = and select 

sum from Objects. 

15  
Match colors of corresponding angles and text. Fix the text that is 
not supposed to be moved. 

5. Constructing a Slope Triangle       

In this activity you are going to use the following tools and algebraic input. Make 
sure you know how to use each tool and the syntax for algebraic input before you 
begin.  
 

 
Line   run = x(B) - x(A) 

 
Perpendicular Line   slope = rise / run 

 
Intersect   

 
Text 

 
Polygon  

 
Midpoint or Center 

 rise = y(B) - y(A)  
 

Move 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Algebra & Graphics and show the  Grid. 

 Set the  Point Capturing to Fixed to Grid. 

 Set the labeling to All New Objects (menu Options – Labeling). 
 

 
 
 

 

https://www.youtube.com/watch?v=g6-xAI6bWms&list=PLITakOESY-2yvF2sKHWJHxiP-Ph7unBHk&index=5
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Construction Steps 

1 
 

Create a line a through two points A and B. 

2 
 

Construct a perpendicular line b to the y-axis through point A. 

3 
 

Construct a perpendicular line c to the x-axis through point B 

4 
 

Intersect perpendicular lines b and c to get intersection point C. 

  Hint: You might want to hide the perpendicular lines. 

5 
 

Create a triangle ACB. 

6 
 

Hide the labels of the triangle sides using the Stylebar. 

7  Calculate the rise: rise = y(B) - y(A). 

  Hint: y(A) gives you the y-coordinate of point A. 

8  Calculate the run: run = x(B) - x(A). 

  Hint: x(B) gives you the x-coordinate of point B. 

9 
 

Insert dynamic text1: rise = and select rise from Objects. 

10 
 

Insert dynamic text2: run = and select run from Objects. 

11  Calculate the slope of line a: slope = rise / run. 

12 
 

Insert dynamic text3: slope = and select slope from Objects. 

13  
Change properties of objects in order to enhance your construction 
and fix text that is not supposed to be moved. 
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6. Dynamic Fractions and Attaching Text to Objects    

Inserting dynamic fractions 

Using LaTeX formulas, text can be enhanced to display fractions, square roots, 
or other mathematical symbols. Enhance your construction of the slope triangle 
by entering a fraction showing how to calculate the slope of a line. 
 

1. Activate tool  Text and click on the Graphics View. 

2. Type slope = into the text window’s Input Bar. 

3. Check LaTeX formula and select Roots and Fractions a/b from the drop-
down list. 

4. Place the cursor within the first set of curly braces and replace a by 
number rise from the Objects drop-down list.  

5. Place the cursor within the second set of curly braces and replace b by 
number run from the Objects drop-down list. 

6. Click OK. 

Attaching text to objects 

Whenever an object changes its position, attached text adapts to the movement 
and follows along. Enhance your construction of a slope triangle by attaching text 
to the sides of the slope triangle. 
 

1. Create midpoint D of the vertical segment using tool  Midpoint or 
Center. 

2. Create midpoint E of the horizontal segment. 
3. Open the Properties dialog and select text1 (rise = …). Click on tab 

Position and select point D from the drop-down list next to Starting Point. 
4. Select text2 (run = …) in the Properties dialog and set point E as Starting 

Point. 
5. Hide the midpoints D and E. 

 
 
 
 
 
 
 
 
 
 
 
 

https://www.youtube.com/watch?v=OpWu1EGcExM&list=PLITakOESY-2yvF2sKHWJHxiP-Ph7unBHk&index=6
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7. The mod 3 Clock         

The mod 3 clock allows you to determine the 
remainder if you divide a given number by 3. In 
this dynamic figure you can create a random 
number between 0 and 100. Moving the blue slider 
causes the hand of the clock to rotate. When the 
value of the slider matches the given number, the 
hand of the clock points at the corresponding 
remainder for division by 3. 
 
Open the link to the dynamic worksheet            
“The mod 3 Clock” 
http://www.geogebratube.org/student/m27287 in 
order to try out this unusual clock. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  

 Algebra & Graphics. 

Introduction of new tools 

 

Ray     New! 
Hint: The first click determines the starting point and the second click determines a point 
on the ray. 

 

Button     New! 
Hint: Click on the Graphics View to insert a button. Then set its caption and OnClick 
script in the appearing dialog.  

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use a tool. 
Try out the new tool before you start the construction. 

Construction Steps 

1  Create points A = (0, 0) and B = (0, 1). 

2 
 

Create circle c with center A through point B. 

3 
 

Zoom into the Graphics View. 

4 
 

Rotate point B clockwise around point A by 120° to get point B’. 

http://www.geogebratube.org/student/m27287
https://www.youtube.com/watch?v=vbmKrAHntcM&list=PLITakOESY-2yvF2sKHWJHxiP-Ph7unBHk&index=7
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5 
 

Rotate point B clockwise around point A by 240° to get point B’1. 

6 
 

Create text1 0, text2 1 and text3 2. 

  Hint: You might want to edit the text (bold, large font size). 

7  
Attach text1 to point B, text2 to point B’ and text3 to point B’1 
(Properties dialog). 

8  
Create a random number between 0 and 100:  
number = RandomBetween[0,100] 

9 
 

Create text5: number = and select number from Objects. 

10 
 

Create text6: The mod 3 Clock 

11 
 

Insert a button with the caption New problem. Enter 

UpdateConstruction[] into the GeoGebraScript text field. 

  
Hint: GeoGebra will update the construction and thus calculate a 
new random number each time you click on the button. 

12 
 

Create a slider n with an Interval from 0 to 100, Increment 1 and 
Width 300 (Tab Slider). 

13 
 

Clockwise angle BAB’2 with given size n*120°. 

14 
 

Ray with starting point A through point B’2. 

15  Create a point D = (0, 0.8). 

16 
 

Create a circle d with center A through point D. 

17 
 

Intersect the ray with circle d to get intersection point C. 

18 
 

Hide the ray and circle d. 

19 
 

Create a vector from A to C. 

20  Change the font size of the GeoGebra window to 20 pt. 

  Hint: Menu Options – Font size 

21  
Use the Properties dialog to enhance your construction and fix text 
and sliders so they can’t be moved accidentally. 
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8. Challenge of the Day: Visualize a Binomial Formula 

Check out the link to the dynamic worksheet “The Binomial Formula” 
http://www.geogebratube.org/student/m27286 It visualizes the binomial formula 

222 2)( bababa ++=+  and contains dynamic text that automatically adapts if the 

values of a and b are changed. Recreate the construction shown in the dynamic 
worksheet. 
 

 
 
Hints: 

 In the Stylebar change Point Capturing to Fixed to Grid. 

 Use static text to label congruent sides of your construction and attach it to 
the midpoints of the corresponding sides. 

 Use static text to label the areas of the different parts of the square and 
attach it to the center of the smaller squares / rectangles. Check the box 
LaTeX formula in order to create the 2 when creating the text. 

 Add dynamic text that adapts to changes of the sides a and b. If you want 
to color code the text you need to create a text for each term. 

 Fix text that is not supposed to be moved by students (Properties dialog). 
 

http://www.geogebratube.org/student/m27286
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1. Introduction: GeoGebraTube and User Forum 

Dynamic Worksheets 

GeoGebra allows you to create your own interactive instructional materials, so 
called dynamic worksheets, by exporting dynamic figures into web pages. 
Usually, a dynamic worksheet consists of a heading, short explanation, 
interactive applet, as well as tasks and directions for your students. 
 
In order to work with dynamic worksheets your students don’t need to know how 
to operate GeoGebra at all. The interactive web pages are independent of the 
software and can be provided either online or on a local storage device. 

GeoGebraTube 

The GeoGebraTube website (http://www.geogebratube.org/) is a pool of free 
instructional materials (e.g. dynamic worksheets) created and shared by teachers 
from all over the world. They are grouped by different tags in order to organize 
their content and make them easier to access. 
 

 
 
All materials on GeoGebraTube are under a Creative Common Attribution-Share 
Alike License (http://creativecommons.org/licenses/by-sa/3.0/). This means that 
you are allowed to use them for free and that you can create derivative work if 
you give credit to the original author. 

http://www.geogebratube.org/
http://creativecommons.org/licenses/by-sa/3.0/
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GeoGebra User Forum 

The GeoGebra User Forum (www.geogebra.org/forum) was created to offer 
additional support for the community of GeoGebra users. Created for teachers 
and maintained by teachers, it is a platform to pose and answer questions related 
to GeoGebra.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The GeoGebra User Forum consists of several discussion boards in different 
languages allowing users to post and answer their GeoGebra related questions 
in their native language. 

http://www.geogebra.org/forum
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2. Lower and Upper Sum              

You will now learn how to create a dynamic 
worksheet that illustrates how lower and upper sums 
can be used to approximate the area between a 
function and the x-axis, which can be used to 
introduce the concept of integral to students. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Algebra & 
Graphics. 

Construction Steps 

1  Enter the cubic polynomial f(x) = -0.5x3 + 2x2 – x + 1. 

2 
 

Create two points A and B on the x-axis. 

  
Hint: These points will determine the interval which restricts the 
area between the function and the x-axis. 

3 
 

Create slider for the number n with Interval 1 to 50 and Increment 1. 

4  Enter uppersum = UpperSum[f, x(A), x(B), n]. 

  
Hint: x(A) gives you the x-coordinate of point A. Number n 

determines the number of rectangles used in order to calculate the 
lower and upper sum. 

5  Enter lowersum = LowerSum[f, x(A), x(B), n]. 

6 
 

Insert dynamic text Upper Sum = and select uppersum from 

Objects. 

7 
 

Insert dynamic text Lower Sum = and select lowersum from 

Objects. 

8  Calculate the difference diff = uppersum – lowersum . 

9 
 

Insert dynamic text Difference = and select diff from Objects. 

10  Enter F = Integral[f, x(A), x(B)]. 

11 
 

Insert dynamic text Integral = and select F  from Objects. 

https://www.youtube.com/watch?v=DjSoMIUkw-w&index=2&list=PLITakOESY-2y_gf2URirnkqPtuT_ZUqNy
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12  Fix slider and text using the Properties dialog. 

Task 

Use slider n in order to modify the number of rectangles used to calculate the 
lower and upper sum.  

1. Compare the values of the upper sum / lower sum to the value of the 
integral for different values of slider n. What do you notice? 

2. What happens to the difference of the upper and lower sum (a) if n is 
small (b) if n is big?  

3. Creating Dynamic Worksheets       

Reducing the size of the GeoGebra window 

GeoGebra will export the currently visible views (e.g. Algebra View, Graphics 
View,…) into the dynamic figure of the worksheet. In order to save space for 
explanations and tasks on the dynamic worksheet you need to make the 
GeoGebra window smaller prior to the export.  

 If you don’t want to include the Algebra View please hide it prior to the 
export. 

 Move your figure (or the relevant section) to the upper left corner of the 

Graphics View using the  Move Graphics View tool.  

Hint: You might want to use the  Zoom in and  Zoom out tools to 
prepare your figure for the export process. 

 Reduce the size of the GeoGebra window by dragging its lower right 
corner with the mouse.  
Hint: The pointer will change its shape when hovering above an edge or 
corner of the GeoGebra window. 

 
Note: Although the interactive applet should fit on one screen and even leave 
some space for text on the worksheet you need to make sure that it is big 
enough to allow students manipulations and experiments. 

Upload to GeoGebraTube 

After adjusting the size of the GeoGebra 
window, you are now ready to export the 
figure as a dynamic worksheet using the File 
menu. 

 File –  Share… 
 

 

https://www.youtube.com/watch?v=LmEZ6syBZS8&index=2&list=PLITakOESY-2y_gf2URirnkqPtuT_ZUqNy
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 The GeoGebraTube website opens automatically where you have to login 
(or register if you do not have an account yet) before you are able to 
continue your upload. 
 
 
 

 Fill in the information for your students including specific tasks for them. If 
you want, you can also select to show the Toolbar, the Input Bar or the 
Menubar. Click Continue. 

 Type a short explanation for other teachers, so that they are able to use 
your materials, too. This information is not shown on the student 
worksheet. Choose a target group and select tags that describe your 
material to help others with searching.  

 Finish your Upload with the Save button. 
 

Your worksheet is now saved on GeoGebraTube where everyone is able to use 
it. 

Tips and Tricks for Creating Dynamic Worksheets 

 After saving the dynamic worksheet it will be automatically opened up in 
your web browser. Check the text you inserted as well as the functionality 
of the interactive applet. If you want to change your dynamic worksheet go 
back to the GeoGebra file and make your changes to the figure. Export 
the figure again (you can use the same file name to overwrite the old 
worksheet) in order to apply your changes.  
Hint: You can change the text of the dynamic worksheet in the same way.  

 GeoGebra automatically saves your entries in the export window for 
dynamic worksheets. If you want to make changes to your figure while 
filling in the export dialog you can just close it and continue later on. 

 Make sure your applet is not too big. Your students shouldn’t have to 
scroll between the tasks and the figure because this makes learning more 
difficult.  

 Your dynamic worksheet should fit on one screen. If you want to include 
more than 3 tasks you should consider creation of another worksheet that 
includes the same dynamic figure but different tasks. 
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Visualizing Triangle Inequalities      

You will now create a dynamic worksheet that illustrates the construction steps 
for a triangle whose three side lengths a, b and c are given. Additionally, this 
worksheet will allow your students to discover triangle inequalities. 
 
Note: The triangle inequalities cba >+ , acb >+ , and bca >+  state that the 
sum of two side lengths of a triangle is greater than the length of the third side of 
the triangle. If the triangle inequalities are not fulfilled for a certain set of side 
lengths, it is not possible to construct a triangle using the given lengths. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  

 Geometry. 
 

Introduction of new tools 

 

Segment with Given Length                            New! 
Hint: First click determines the starting point of the segment. Enter the length of the 
segment into the appearing text field.  

 

Circle with Center and Radius               New! 
Hint: First click determines the center of the circle. Enter the length of the radius into the 
appearing text field.  

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use a tool. 
Try out the new tools before you start the construction. 

Construction Steps 

1 
 

Create sliders a, b and c for the side lengths of the triangle with an 
Interval from 0 to 10 and Increment 0.5. 

2 
 

Set the sliders to a = 8, b = 6.5 and c = 10. 

3 
 

Create segment d with given length c. 

  Hint: Points A and B are the endpoints of the segment. 

4 
 

Create a circle e with center A and radius b. 

5 
 

Create a circle f with center B and radius a. 

https://www.youtube.com/watch?v=KReAvs_-twY&index=3&list=PLITakOESY-2y_gf2URirnkqPtuT_ZUqNy
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6 
 

Construct the intersection point C of the two circles e and f. 

7 
 

Create the triangle ABC. 

8 
 

Create interior angles α, β and γ of triangle ABC. 

Enhancements            

Prepare your triangle construction for the export as a dynamic worksheet.  
 

9 
 

Create a point D on circle e. 

10 
 

Create segment g between the points A and D. 

11 
 

Construct the midpoint E of segment g. 

12 
 

Enter text1: b and attach it to point E. 

13 
 

Create a point F on circle f. 

14 
 

Create segment h between points B and F. 

15 
 

Construct the midpoint G of segment h. 

16 
 

Enter text2: a and attach it to point G. 

17  Match colors of corresponding objects. 

18  Show the Navigation Bar (right-click the Graphics View). 

19 
 

Open the Construction Protocol (menu View). 

20 
 

Show the column Breakpoint. 

21  
Change the order of construction steps so that the radius of the 
circles and the attached text show up at the same time. 

  
Hint: You might also set some other breakpoints (e.g. show all 
sliders at the same time). 

22 
 

Now check Show Only Breakpoints. 

https://www.youtube.com/watch?v=3-jmf6YYQAs&index=4&list=PLITakOESY-2y_gf2URirnkqPtuT_ZUqNy
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Tasks 

(a) Export your triangle construction as a 
dynamic worksheet.  
 
(b) Come up with explanations and tasks for 
your students that guide them through the 
construction process of the triangle and help 
them explore the triangle inequalities by 
modifying the given side lengths using the 
sliders.  

4. Design Guidelines for Dynamic Worksheets  

The following design guidelines for dynamic worksheets are the result of a 
formative evaluation of dynamic worksheets created by teachers in our NSF MSP 
classes during fall 2006 and spring 2007. The guidelines are based on design 
principles for multimedia learning stated by Clark and Mayer1.  
 
These guidelines were summarized to address and avoid common mistakes 
during the creation process of dynamic worksheets as well as to increase their 
quality with the hope that they will foster more effective learning. Although some 
of these guidelines may seem obvious, we have found it very important in our 
work with teachers to discuss and explain them in detail.  
 
The following figure shows a dynamic worksheet created with GeoGebra that 
allows students to explore properties of the orthocenter of a triangle. By 
modifying the dynamic construction students can examine the orthocenter of a 
great variety of triangles instead of just one special case. Several key words 
within the explanation and tasks match the color of the corresponding objects in 
order to facilitate finding them within the construction. Furthermore, the tasks are 
placed next to the dynamic construction in order to fit all information on one 
screen and avoid additional cognitive load through scrolling. 
 
  

                                            
1
 Clark, R. and Mayer, R.E. (2002): e-Learning and the Science of Instruction. San Francisco: 

Pfeiffer, 2002 
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Design Guidelines 1: Layout of Dynamic Worksheets 

Avoid scrolling 

Your entire worksheet should fit on one screen. Students should not have to 
scroll between the tasks and the interactive figure. We consider 1024x768 or 
1280x1024 pixels as today's usual screen size which constrains the size of the 
dynamic worksheet. Using an HTML editor like NVU you can use tables to 
arrange text, images and interactive figures so they fit on one screen. If this is not 
possible, consider breaking the dynamic worksheet into several pages. 

Short explanation 

At the beginning of a dynamic worksheet, you should give an explanation of its 
content. Keep the text short (no more than one or two sentences) and write it in a 
personal style. 

Few tasks 

You will usually add questions or tasks to make sure that your students use the 
worksheet actively. Place these tasks close to the interactive applet (e.g. directly 
below it). Don't use more than three or four questions / tasks to avoid scrolling. If 
you have more tasks, consider breaking your worksheet into several pages. 



 

Introduction to GeoGebra   
 

 

 81   

Avoid distractions 

Make sure that your dynamic worksheet just contains objects that are relevant for 
the objectives. Neither use unnecessary background or purely decorative 
images, nor background music on the web page in order not to distract your 
students from reaching the objectives. 

Design Guidelines 2: Dynamic Figures 

Interactivity 

Allow as much interactivity as possible in your dynamic figure. As a rule of 
thumb, all visible objects should be movable or changeable in some way. Your 
dynamic figure should provide plenty of freedom to explore the relations of its 
mathematical objects and discover mathematical concepts. 

Easy-to-use 

Try to make your dynamic figure as easy to use as possible. If an object can be 
moved or changed, try to make this obvious, e.g. all movable points could be red 
or larger in size. If you don't want objects to be changed, fix them (e.g. text, 
functions or slider positions) so they cannot be moved accidentally. 

Size matters 

Your dynamic figure should be large enough to allow all intended manipulations, 
but small enough to fit on one screen and still leave sufficient space for 
explanations and questions on the surrounding web page. 

Use dynamic text 

Dynamic text, like the length of a changeable segment, should be placed close to 
the corresponding object in your applet. 

Avoid static text 

Too much text can easily clutter your interactive applet. Instead, place static text 
like explanations or questions on the web page that includes your dynamic figure. 

First appearance 

When a dynamic worksheet is opened you should be able to read all labels and 
important information. For example, a point label should not be crossed by a line. 
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Design Guidelines 3: Explanations and Tasks 

Short, clear and personal style 

Try to write your explanations and questions in a short, clear and conversational 
style. Use the term ‘you' within the text and try to address the students directly. 

Small number of questions 

Limit your number of questions or tasks per worksheet to three or four to avoid 
scrolling. If you want to ask more questions, create a new worksheet. 

Use specific questions 

Avoid general questions like ‘What is always true about X?' and make clear what 
the students should do, e.g. `What happens to X when you move Y?'. We 
recommend that your students should take notes while they work with a dynamic 
worksheet. If you want them to write down their answers on paper, say so on the 
worksheet. 

Refer to your applet 

Your text should support the use of your interactive applet. For example, try to 
explain a new term by referring to your applet instead of using an isolated textual 
definition. Additionally, you can color certain keywords to match the formatting 
style of the object they refer to. This makes the text easier to read and helps your 
students to find corresponding representations of the same object. 

Your audience are learners 

If you want to provide information for other educators (e.g. lesson plan, solutions) 
do so in a separate document (e.g. web page, pdf-document). Your students 
should not be distracted or confused by such information. 

Demonstration figure 

If your interactive figure is meant for presentation only it might be better to have 
no tasks or questions on the web page. If you include text, it should be 
understandable for students as well. 
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5. Creating a ‘Tangram’ Puzzle                    

In this activity you will create the ‘Tangram’ puzzle shown at 
the right hand side. It consists of 7 geometric shapes which 
can all be constructed using the side length a of the main 
square. Check out the link to the dynamic worksheet 
http://www.geogebratube.org/student/m27289 “’Tangram’ 
Puzzle” in order to find out how a ‘Tangram’ works.  

Task 1: Figure out the side lengths of each part 

In order to construct the parts of the ‘Tangram’ puzzle you need to figure out the 
individual side lengths of the seven geometric figures first. They all depend on 
the side length a of the main square. 
 

Hint: In some cases you might want to look at the diagonals or height. Their 
lengths can be expressed more easily using the variable a than the lengths of the 
corresponding sides. 

Task 2: Construct the individual parts of the ‘Tangram’ 

1. Enter the number a = 6. It will provide a basis for the construction of all 

triangles and quadrilaterals necessary for your ‘Tangram’ puzzle. 

2. Construct the geometric shapes using one of the tools  Segment With 

Given Length or  Rigid Polygon. This will allow you to drag and rotate 
the shape later on.  
Hint: You need to figure out the side lengths of the geometric shapes 
before you are able to construct them in GeoGebra. 

3. Construction hints: 
a. If the height of a right triangle is half the length of the hypotenuse 

you might want to use the theorem of Thales for the construction 
(see Workshop Handout 2, Chapter 4). 

b. If you know the legs of a right triangle you might want to construct it 
similar to the square construction presented earlier.  

c. For constructing a square using its diagonals, it is helpful to know 
that they are perpendicular and bisect each other. 

d. For constructing the parallelogram it is helpful to know the size of 
the acute angle. 

4. Check your construction by trying out if you can manage to create a 
square with side length a using all figures. 

5. Arrange the geometric shapes arbitrarily around the edges of the 
interactive applet. Export the figure to a dynamic worksheet and add an 
explanation for your students. 

http://www.geogebratube.org/student/m27289
https://www.youtube.com/watch?v=HcUrZH5enqY&index=5&list=PLITakOESY-2y_gf2URirnkqPtuT_ZUqNy
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6. Challenge of the Day: Enhance Your ‘Tangram’ Puzzle 

With these geometric shapes other figures than a square can be 
created as well. Search the Internet for a ‘Tangram’ figure other than 
a square (e.g. http://www.geogebra.org/book/intro-
en/worksheets/tangram_cat.png) and import this figure into the 
Graphics View. Export the GeoGebra construction again using a 
different name and different instructions (see 
http://www.geogebratube.org/student/m27288). 
 

http://www.geogebra.org/book/intro-en/worksheets/tangram_cat.png
http://www.geogebra.org/book/intro-en/worksheets/tangram_cat.png
http://www.geogebratube.org/student/m27288
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1. The Theorem of Pythagoras       

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Change the labeling setting to New Points Only 
(menu Options – Labeling). 

Construction Steps 

1 
 

Create segment a with endpoints AB. 

2 
 

Create semicircle c through points A and B. 

3 
 

Create a new point C on the semicircle. 

 
 

Hint: Check if point C really lies on the arc by dragging it with the 
mouse. 

4 
 

Hide the segment and the semicircle. 

5 
 

Construct a triangle ABC in counterclockwise direction. 

6  Rename the triangle sides to a, b and c. 

7 
 

Create interior angles of triangle ABC. 

  Hint: Click in the middle of the polygon to create all angles. 

8 
 

Drag point C to check if your construction is correct. 

9 
 

Create a perpendicular line d to segment BC through point C. 

10 
 

Create a perpendicular line e to segment BC through point B. 

11 
 

Create a Circle f with center C through point B. 

12 
 

Intersect the circle f and the perpendicular line d to get intersection 
point D. 

13 
 

Create a parallel line g to segment BC through point D. 

14 
 

Create intersection point E of lines e and g. 

15 
 

Create the square CBED. 

https://www.youtube.com/watch?v=ITZ1a9Ec3ds&index=2&list=PLITakOESY-2waUioLF8tevP84fihPEji9
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16 
 

Hide the auxiliary lines and circle. 

17  Repeat steps 8 to 15 for side AC of the triangle. 

18  Repeat steps 8 to 15 for side AB of the triangle. 

19 
 

Drag the vertices of the right triangle to check if your squares are 
correct. 

20  Enhance your construction using the Stylebar. 

Enhancing the construction 

Insert static and dynamic text into your construction that helps to understand the 
Pythagorean theorem a2 + b2 = c2 where a and b are the legs and c is the 
hypotenuse of a right triangle. 
 
 
 
 
 
 
 

 

Introduction of new tool 

 

Copy Visual Style  New! 
Hint: Click on an object to copy its visual style. Then, click on other objects to match 
their visual style with the first object. 

 
Hints: Don’t forget to read the Toolbar help if you don’t know how to use the tool. 
Try out the new tool before you start the construction. 

Construction Steps 

21 
 

Create the midpoints of all three squares. 

  Hint: Click on diagonal opposite vertices of each square. 

22 
 

Insert static text1: a^2 and attach it to the midpoint of the 

corresponding square. 

  Hint: Don’t forget to check the box LaTeX formula to get a2. 

23 
 

Insert static text2: b^2 and attach it to the midpoint of the 

corresponding square. 
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24 
 

Insert static text3: c^2 and attach it to the midpoint of the 

corresponding square. 

25 
 

Hide the midpoints of the squares. 

26 
 

Format the text to match the color of the corresponding squares. 

27 
 

Insert text that describes the Pythagorean theorem. 

28  
Export your construction as a dynamic worksheet. Come up with an 
explanation that helps your students understand the theorem of 
Pythagoras. 

2. Creating Custom Tools        

GeoGebra allows you to create custom tools. This means that you can extend 
the Toolbar by creating your own tools. Let’s now create a tool that determines 
the minimal distance between a line and a point (e.g. altitude in a triangle). 
Before you can create your custom tool you need to construct all the objects 
required for your tool. 

Prepare the construction 

Preparations 

 Open a new GeoGebra window.  

 Switch to Perspectives –  Geometry. 

 Change the labeling setting to All New 
Objects (menu Options – Labeling). 

Construction Steps 

1 
 

Create line a through two points A and B. 

2 
 

Insert a new point C. 

3 
 

Create perpendicular line b to line a through point C. 

4 
 

Construct intersection point D of lines a and b. 

5 
 

Create segment c between points C and D. 

6 
 

Drag points A, B and C to check your construction. 

7  Change the color of segment c and hide the labels of all objects. 

https://www.youtube.com/watch?v=6VJzOLYLD8Q&list=PLITakOESY-2waUioLF8tevP84fihPEji9&index=2
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Create a custom tool 

1. In menu Tools click on  Create New 
Tool… to open the Create New Tool dialog. 

 

2. By default, tab Output Objects is activated.  
 

3. Specify the output objects of your new tool 
by either clicking on the desired output 
object on the drawing pad (our example: 
segment c) or selecting it from the drop 
down menu (click on the little arrow next to 
the input field). 

 

4. Click the Next > button in order to activate 
tab Input Objects.  

 

5. GeoGebra fills in the corresponding input 
objects for your tool automatically (our 
example: points A, B and C).  
Note: GeoGebra picks all so-called ‘parent 
objects’ of the output objects you specified. 

 

6. Click the Next > button in order to activate 
tab Name & Icon. 

 

7. Fill in a name for your tool and text for the 
Toolbar help.  
Note: GeoGebra fills in the text field 
Command name automatically. 

 

8. Click the button Finish.  
 
Hint: Your new tool is now part of the GeoGebra Toolbar.  

Try out your custom tool 

1. Open a new GeoGeba window using menu File – 
New.   
Note: Your custom tool is still part of the Toolbar. 

2. Create a triangle ABC using tool Polygon. 
3. Activate your custom tool Altitude.  
4. Click on points A, B and C in order to create one of 

the triangle’s altitudes.  
5. Create another altitude of the triangle. 
6. Intersect the two altitudes to get the orthocenter of the triangle. 
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3. Saving and Importing Custom Tools     

Save your custom tool 

1. In menu Tools click on  Manage tools… to open the Manage tools 
dialog window. 

2. Select your custom tool Altitude from the list of available tools. 
3. Click on button Save as… in order to save your custom tool and make it 

available for future constructions. 
4. Choose a name for your custom tool (e.g. Altitude_tool.ggt) and save it on 

your computer.  
 
Hint: Custom GeoGebra tools are saved with the file name extension .ggt. This 
helps you to distinguish between ‘usual’ GeoGebra files (extension .ggb) and 
custom tool files. 

Import a custom tool 

After saving your custom tool you are able to reuse it in future constructions. By 
default the GeoGebra Toolbar doesn’t include any custom tools. In order to reuse 
one of your custom tools you need to import it into your new GeoGebra window. 

1. Open a new GeoGebra window. 

2. In menu File click on  Open. 
3. Look for the custom tool you saved earlier (e.g. Altitude_tool.ggt) and 

select it from the list of available GeoGebra files (.ggb) and tool files (.ggt). 
4. Click the Open button to import your custom tool into the Toolbar of the 

new GeoGebra window. 
 
Hint: Importing a custom tool doesn’t affect the construction in your GeoGebra 
window. Thus, you can also import custom tools during a construction process. 

https://www.youtube.com/watch?v=Rcol18K04zw&list=PLITakOESY-2waUioLF8tevP84fihPEji9&index=3
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4. Creating a Square Tool        

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry.  

 Change the labeling setting to All New Objects 
(menu Options – Labeling). 

Construction Steps 

1 
 

Create segment a with endpoints AB. 

2 
 

Create perpendicular line b to segment AB through point B. 

3 
 

Create a circle c with center B through point A. 

4 
 

Intersect circle c and perpendicular line b to get intersection point C. 

5 
 

Construct a parallel line d to perpendicular line b through point A. 

6 
 

Construct a parallel line e to segment a through point C. 

7 
 

Intersect lines d and e to get intersection point D. 

8 
 

Create the square ABCD. 

9 
 

Hide auxiliary objects (lines and circle). 

10 
 

Hide labels of all objects (Stylebar). 

11  Set the square’s color to black and set the Opacity to 0%. 

12  Create your square tool (menu Tools – Create New Tool…). 

  

Output objects: square, sides of the square, points C and D 
Input objects: points A and B 
Name: Square 
Toolbar help: Click on two points 

13  
Save your square tool as file Square_Tool.ggt 
Hint: Menu Tools – Manage Tools… – Save as… 

Task 

Compare the construction process of this square with the one you used in 
workshop 2. What are the differences? 

https://www.youtube.com/watch?v=mplS201kzjY&index=4&list=PLITakOESY-2waUioLF8tevP84fihPEji9
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5. The Fibonacci Spiral         

A Fibonacci spiral can be created 
by drawing arcs connecting the 
opposite corners of squares in 
the Fibonacci tiling which uses 
squares of sizes 1, 1, 2, 3, 5, 8, 
13, 21,…  
The Fibonacci spiral 
approximates the so called 
Golden Spiral which is a 
logarithmic spiral whose growth 
factor is related to the golden 
ratio. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Import your Square tool into the Toolbar (menu File – Open). 

 Change the labeling setting to No New Objects (menu Options – 
Labeling). 

Introduction of new tool 

 

Circular Arc    New! 
Hint: Click on the center point of the circular arc. Then, specify two points that 
determine the radius and length of the arc. 

 

Hints: Don’t forget to read the Toolbar help if you don’t know how to use the tool. 
Try out the new tool before you start the construction. 

Construction Steps 

1  Use your Square tool to create a square with side length 1. 

  Hint: Place the two points on grid points that are next to each other. 

2  Create a second square with side length 1 below the first square. 

  Hint: Use already existing points to connect both squares. 

3  
Create a third square with side length 2 on the right hand side of the 
two smaller squares. 

https://www.youtube.com/watch?v=pUcBaVVjZ8s&list=PLITakOESY-2waUioLF8tevP84fihPEji9&index=5


 

Introduction to GeoGebra   
 

 

 93   

4  
Continue creating squares with side lengths 3, 5, 8 and 13 in counter 
clockwise direction. 

5 
 

Create a circular arc within the first square you created.  

  
Hint: Specify the lower right vertex of the square as the center of the 
arc. Select two opposite vertices of the square in counter clockwise 
orientation. 

6  
Repeat step 5 for each of the squares in order to construct the 
Fibonacci spiral. 

7  Enhance your construction using the Stylebar. 

6. Constructing the Center of a Circle      

Back to school… 

Do you know how to construct the center of a circle?  
Print the page with circles at the end of this chapter and try to find a way of 
finding the center of these circles (a) only by folding the paper and (b) with pencil 
and ruler. 
 

Hints: 

 Version 1a: Fold two circle diameters which intersect in the circle’s center. 

 Version 1b: Can you recreate this construction using pencil and ruler? 

 Version 2a: Fold two chords of the circle as well as their perpendicular 
bisectors which intersect in the center of the circle. 

 Version 2b: Can you recreate this construction using pencil and ruler? 
 

Now use GeoGebra in order to recreate the construction you used in version 2b. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Show the Input Bar (View menu). 

Construction Steps 

1  Enter circle c’s equation: x^2 + y^2 = 16. 

2 
 

Create chord a of circle c. 

  Hint: A chord is a segment whose endpoints both lie on the circle. 

https://www.youtube.com/watch?v=zrlaow2DLeE&index=6&list=PLITakOESY-2waUioLF8tevP84fihPEji9
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3 
 

Create midpoint C of chord a. 

4 
 

Create perpendicular line b to the chord a through point C. 

  Hint: You just created the perpendicular bisector of chord a. 

5 
 

Create another chord d of circle c. 

6 
 

Create midpoint F of chord d. 

7 
 

Create perpendicular line e to chord d through point F. 

8 
 

Intersect lines b and e to get intersection point G. 

  Hint: Point G is the center of circle c. 

9  Enhance your construction using the Stylebar. 

10 
 

Check your construction for different positions of the chords. 

Tasks 

 Right-click (MacOS: Ctrl-click) the 
Graphics View and show the Navigation 
Bar to review the construction steps. 

 

 Open the  Construction Protocol 
(menu View) and show the column  

 Breakpoint to group some of the 
objects you used. After specifying your 

breakpoints, check  Show Only 
Breakpoints. 

 

 Export the construction as a dynamic worksheet that includes the 
Navigation Bar (Export dialog – tab Advanced) and save the file as 
Center_Circle_Solution.html. 

 

 Open the dynamic worksheet you just exported. Use the Navigation Bar to 
review your construction and write down which tools you used in order to 
construct the center of the circle. 
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7. Customizing the Toolbar        

You will now learn how to customize GeoGebra’s Toolbar so you can limit the 
number of available tools for your students. 
 

 
1. In the Tools menu click on Customize Toolbar… 
2. At the top of the window you can choose different default Toolbars 

(General, Spreadsheet, CAS and Data Analysis) from the drop-down 
menu. 

3. The window on the left hand side 
lists all GeoGebra tools that are 
part of the chosen Toolbar. If you 
click on one of the + symbols in 
front of the tool names the 
corresponding toolbox is opened. 

4. In the left hand side list click on 
the + symbol in front of the         

 Move tool to open the toolbox. 

Select tool  Move around Point 

and click the Remove> button. Then select tool  Record to Spreadsheet 

and click the Remove> button again. The  Move tool will now be the 

only tool left in the toolbox  Move. 
5. Now open the next toolboxes and remove all tools except those, you need 

to construct a circle’s center (  Intersect,  Midpoint or Center,  

Segment,  Perpendicular Line). 
6. Use the Up and Down buttons to change the order of the tools in the left 

hand side list. 
7. Click Apply once you are done. 
8. Your GeoGebra window should now show the customized Toolbar. 

Task 

 Delete all objects apart from the circle. 

 Export this updated construction as a dynamic worksheet that includes the 
customized Toolbar and shows the Toolbar help (Export dialog – tab 
Advanced). 

 Save the dynamic worksheet as Center_Circle_Construction.html. 

https://www.youtube.com/watch?v=R4vC9tARRl0&index=7&list=PLITakOESY-2waUioLF8tevP84fihPEji9
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8. Challenge of the Day: Euler’s Discovery     

Task 

 Construct the following three ‘remarkable’ points of a triangle: 
circumcenter, orthocenter and centroid. Create a custom tool for each of 
these points. Save your custom tools. 

 Use your custom tools within one construction to find the relation between 
these three points as the Swiss mathematician Euler did in the 18th 
century, obviously without having access to dynamic geometry software ;-)  

Circumcenter of a Triangle 

Preparations 

 Open new GeoGebra window. 

 Switch to Perspectives -  Geometry. 

 Change the labeling setting to New 
Points Only (menu Options – Labeling). 

Construction Steps 

1 
 

Create an arbitrary triangle ABC. 

2 
 

Create perpendicular bisectors d, e and f for all sides of the triangle. 

  
Hint: The tool Perpendicular Bisector can be applied to an existing 
segment. 

3 
 

Construct intersection point D of the two of the line bisectors. 

4 
 

Create a circle with center D through one of the vertices of triangle 
ABC. 

5  Rename point D to Circumcenter.  

6 
 

Use the drag test to check if your construction is correct. 

7  Create a custom tool for the circumcenter of a triangle. 

  

Output objects: point Circumcenter 
Input objects: points A, B and C 
Name: Circumcenter 
Toolbar help: Click on three points 

8  Save your custom tool as file circumcenter.ggt. 

https://www.youtube.com/watch?v=Bn1T1olLbUU&index=8&list=PLITakOESY-2waUioLF8tevP84fihPEji9
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Orthocenter of a Triangle 

Preparations 

 Open new GeoGebra window. 

 Switch to Perspectives – 

  Geometry. 

 Change the labeling setting to New 
Points Only (menu Options – 
Labeling). 

Construction Steps 

1 
 

Create an arbitrary triangle ABC. 

2 
 

Create perpendicular lines d, e and f to each side through the 
opposite vertex of the triangle. 

3 
 

Construct intersection point D of two of the perpendicular lines. 

4  Rename point D to Orthocenter.  

5 
 

Use the drag test to check if your construction is correct. 

6  Create a custom tool for the orthocenter of a triangle. 

  

Output objects: point Orthocenter 
Input objects: points A, B and C 
Name: Orthocenter 
Toolbar help: Click on three points 

7  Save your custom tool as file orthocenter.ggt. 

Centroid of a Triangle 

Preparations 

 Open new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Change the labeling setting to New 
Points Only (menu Options – Labeling). 

Construction Steps 

1 
 

Create an arbitrary triangle ABC. 
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2 
 

Create midpoints D, E and F of the triangle sides. 

3 
 

Connect each midpoint with the opposite vertex using segments d, e 
and f. 

4 
 

Create intersection point G of two of the segments. 

5  Rename point G to Centroid. 

6 
 

Use the drag test to check if your construction is correct. 

7  Create a custom tool for the centroid of a triangle. 

  

Output objects: point Centroid 
Input objects: points A, B and C 
Name: Centroid 
Toolbar help: Click on three points 

8  Save your custom tool as file centroid.ggt. 

What was Euler’s discovery? 

Task 1 

 Open a new GeoGebra window and import your three custom tools 
(circumcenter.ggt, orthocenter.ggt and centroid.ggt) into the Toolbar. 

 Create an arbitrary triangle ABC and apply all three custom tools to the 
triangle in order to create the circumcenter, orthocenter and centroid 
within the same triangle. 

 Move the vertices of triangle ABC and observe the three ‘remarkable’ 
points you just constructed. Which relationship do they have? Use one of 
GeoGebra’s geometry tools in order to visualize this relationship. 

Task 2 

 Open an empty GeoGebra window. Customize the Toolbar so it only 
consists of the following tools: Move, Polygon, Line, Circle with Center 
through Point, Circumcenter, Orthocenter and Centroid. 

 Export this empty GeoGebra window as a dynamic worksheet that 
includes the customized Toolbar as well as the Toolbar help. Come up 
with instructions that guide your students towards discovering the Euler 
line in a triangle. 
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Constructing the Center of a Circle Worksheet 
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1. Visualizing Integer Addition on the Number Line     

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Show the Input Bar (View menu). 

 In the Options menu set Labeling to All New Objects. 
 

 

Construction Steps 

1  Open the Properties dialog for the Graphics View.  

  Hint: Choose  Preferences and then  Graphics.  

2  
On tab xAxis set the distance of tick marks to 1 by checking the box 
Distance and entering 1 into the text field.  

3  
On tab Basic set the minimum of the x-Axis to -21 and the 
maximum to 21. 

4  On tab yAxis uncheck Show yAxis. 

5  Close the Properties dialog for the Graphics View. 

6 
 

Create a slider for number a with Interval -10 to 10 and Increment 
1. 

7 
 

Create a slider for number b with Interval -10 to 10 and Increment 
1. 

8  Show the value of the sliders instead of their names. 

  Hint: Stylebar - Set label style - Value 

9 
 

Create point A = (0 , 1). 

10  Create point B = A + (a , 0). 

  Hint: The distance of point B to point A is determined by slider a. 

https://www.youtube.com/watch?v=8l3o0PFt0jU&list=PLITakOESY-2xJ5SIit2it8Mc5Y6uO8uy8&index=2
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11 
 

Create a vector u = Vector[A, B] which has the length a. 

12  Create point C = B + (0 , 1). 

13  Create point D = C + (b , 0). 

14 
 

Create vector v = Vector[C , D] which has the length b. 

15  Create point R = (x(D) , 0). 

  
Hint: x(D) gives you the x-coordinate of point D. Thus, point R 

shows the result of the addition on the number line. 

16 
 

Create point Z = (0, 0). 

17 
 

Create segment g = Segment[Z, A]. 

18 
 

Create segment h = Segment[B, C]. 

19 
 

Create segment i = Segment[D, R]. 

20  
Use the Properties dialog to enhance your construction (e.g. match 
the color of sliders and vectors, line style, fix sliders, hide labels). 

Insert dynamic text 

Enhance your interactive figure by inserting dynamic text that displays the 
corresponding addition problem. In order to display the parts of the addition 
problem in different colors you need to insert the dynamic text step by step. 
 

 
 

1  Calculate the result of the addition problem: r = a + b 

2 
 

Insert dynamic text1: a 

3 
 

Insert static text2: + 

4 
 

Insert dynamic text3: b 

5 
 

Insert static text4: = 
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6 
 

Insert dynamic text5: r 

7  
Match the color of text1, text3 and text5 with the color of the 
corresponding sliders, vectors and point R. 

8 
 

Line up the text on the Graphics View. 

9  Hide the labels of the sliders and fix the text (Properties dialog). 

10  Export your interactive figure as a dynamic worksheet. 

2. Animating Constructions         

GeoGebra offers the possibility to animate sliders (numbers, angles) and points 
on paths (segment, line, function, curve, etc.). While an animation is running, 
GeoGebra remains fully functional. This allows you to make changes to your 
construction while the animation is playing. 
 

Construction Steps 

1  Open the GeoGebra file you created in the previous activity.  

2  

Right-click (MacOS: Ctrl-click) slider a and choose Animation On 
from the appearing context menu.  
Hint: an animation button appears in the lower left corner of the 

Graphics View. It allows you to either  pause or  continue an 
animation. 

3  

Right-click (MacOS: Ctrl-click) slider b and choose Animation On 
from the appearing context menu. 
Hint: In order to stop the animation of this slider, you can un-check 
Animation On in the context menu. 

4  

Open the Object Properties dialog for slider a and b and choose tab 
Slider. There you can change the behavior of the animation (see 
details below). Try out different settings for the sliders and 
determine the impact of the animation on the result r. 

 
 

https://www.youtube.com/watch?v=yAdIk20LviQ&list=PLITakOESY-2xJ5SIit2it8Mc5Y6uO8uy8&index=2
http://wiki.geogebra.org/en/File:Animate_Pause.png
http://wiki.geogebra.org/en/File:Animate_Play.png
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In the Object Properties dialog you can change the behavior of your animation: 
 
Speed: A speed of 1 means that the animation takes about 10 seconds to run 
through the slider interval once. 
 
Repeat:  

⇔ Oscillating 
 The animation cycle alternates between Decreasing and Increasing. 

⇒ Increasing 
The slider value is always increasing. After reaching the maximum value of 
the slider, it jumps back to the minimum value and continues the animation. 

⇐ Decreasing 
The slider value is always decreasing. After reaching the minimum value of 
the slider, it jumps back to the maximum value and continues the animation. 

⇒ Increasing (Once) 
The slider value is increasing. After reaching the maximum value of the 
slider, the animation stops. 
 

 
 
 

http://wiki.geogebra.org/en/Properties_Dialog


 

Introduction to GeoGebra   
 

 

 105   

3. Conditional Formatting – Inserting Checkboxes   

Introduction of new tool 

 

Check Box    New! 
Hint: Click on the Graphics View to open the checkbox dialog window. Enter a caption 
and select the objects you want to show / hide using the checkbox from the drop down 
menu. 

Construction Steps 

Insert a checkbox into the Graphics View that allows you to show or hide the 
result of the addition problem. 
 

 
 

1 
 

Activate tool Check Box. 

2  
Click on the Graphics View next to the result of the addition 
problem to open the checkbox dialog window. 

3  Enter Show result into the Caption text field. 

4  
From the drop down menu select text5. The visibility of this object 
will be controlled by the checkbox. 

  
Hint: You can also click on text5 in the Graphics View to insert it 
into the list of objects influenced by the checkbox. 

5  Click Apply to create the checkbox. 

6 
 

In Move mode check and uncheck the checkbox to try out if text5 
can be hidden / shown. 

7  
Fix the checkbox so it can’t be moved accidentally any more 
(Properties dialog). 

8  Export this new interactive figure as a dynamic worksheet. 

  Hint: You might want to use a different name for this worksheet. 

https://www.youtube.com/watch?v=F-jJOmnTEWs&list=PLITakOESY-2xJ5SIit2it8Mc5Y6uO8uy8&index=3
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Boolean variables 

A Check Box is the graphical representation of a Boolean variable in GeoGebra. 
It can either be true or false which can be set by checking (Boolean variable = 
true) or unchecking (Boolean variable = false) the checkbox. 
 

1. Open the Properties dialog. The list of Boolean values only contains one 
object called c, which is represented graphically as your checkbox. 

2. Select text5 from the list of objects on the left side of the Object Properties 
dialog.  

3. Click on tab Advanced and look at the text field called Condition to Show 
Object. It shows the name of your checkbox c.   
Hint: This means that the visibility of text5 depends on the status of the 
checkbox. 

4. Select point R from the list of objects in the Properties dialog. Click on tab 
Advanced. The text field Condition to Show Object is empty. 

5. Enter j into the text field Condition to Show Object. The visibility of point R 

is now connected to the checkbox as well. 
6. Repeat steps 4 and 5 for segment i which connects the second vector with 

point R on the number line. 
 
Hint: Now the checkbox controls three objects of your dynamic figure: text5 
(which shows the result of the addition), point R and segment i (which show the 
result on the number line). 



 

Introduction to GeoGebra   
 

 

 107   

4. The Sierpinski Triangle        

You will now learn how to create a custom 
tool that facilitates the construction of a so 
called Sierpinski triangle. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives – 

  Geometry. 

 In the Options menu set the Labeling 
to New Points Only. 

Construction Steps 

1 
 

Create an arbitrary triangle ABC. 

2  Change the color of the triangle to black (Stylebar). 

3 
 

Create midpoint D of triangle side AB. 

4 
 

Create midpoint E of triangle side BC. 

5 
 

Create midpoint F of triangle side AC. 

6 
 

Construct a triangle DEF. 

7  
Change the color of triangle DEF to white and increase the filling to 
100% (Properties dialog). 

8  
Change the color of the sides of triangle DEF to black (Properties 
dialog). 

9  Create a new tool called Sierpinski (menu Tools). 

  

Output objects: points D, E and F, triangle DEF, sides of triangle 
DEF 
Input objects: points A, B and C 
Name: Sierpinski 
Toolbar help: Click on three points 

10  
Apply your custom tool to the three black triangles ADF, DBE and 
FEC to create the second stage of the Sierpinski triangle. 

11  
Apply your custom tool to the nine black triangles to create the third 
stage of the Sierpinski triangle. 

https://www.youtube.com/watch?v=tmmHEa6j-_k&list=PLITakOESY-2xJ5SIit2it8Mc5Y6uO8uy8&index=4
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Conditional Visibility 

Insert checkboxes that allow you to show and 
hide the different stages of the Sierpinski 
triangle. 
 

1 
 

Hide all points except from A, B and C. 

2 
 

Create a Check Box that shows / hides the first stage of the 
Sierpinski triangle. 

  
Caption: Stage 1 
Selected objects: Only the large white triangle and its sides. 

3 
 

In Move mode check and uncheck the checkbox to try out if the 
white triangle and its sides can be hidden / shown. 

4 
 

Create a Check Box that shows / hides the second stage of the 
Sierpinski triangle. 

  
Caption: Stage 2 
Selected objects: Three medium sized white triangles and their 
sides. 

5 
 

In Move mode check and uncheck the checkbox to try out if the 
second stage of the Sierpinski triangle can be hidden / shown. 

6 
 

Create a Check Box that shows / hides the third stage of the 
Sierpinski triangle. 

  
Caption: Stage 3 
Selected objects: Nine small white triangles and their sides. 

7 
 

In Move mode check and uncheck the checkbox to try out if the 
third stage of the Sierpinski triangle can be hidden / shown. 
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5. Introducing Sequences        

GeoGebra offers the command Sequence which produces a list of objects. 
Thereby, the type of object, the length of the sequence (that’s the number of 
objects created) and the step width (e.g. distance between the objects) can be 
set using the following command syntax:  
 
Sequence[<Expression>, <Variable>, <Start Value>,  

    <End Value>, <Increment>] 

 
Explanations:  

 <Expression>:   

Determines the type of objects created. The expression needs to contain a 

variable (e.g. (i, 0) with variable i). 

 <Variable>:   

Tells GeoGebra the name of the variable used. 

 <Start Value>, <End Value>:  

Determine the interval for the variable used (e.g. from 1 to 10). 

 <Increment>:   

Is optional and determines the step width for the variable used (e.g. 0.5). 

Examples for sequences 

 Sequence[(n, 0), n, 0, 10]  

o Creates a list of 11 points along the x-axis. 
o Points have coordinates (0, 0), (1, 0), (2, 0), …, (10, 0). 

 

 
 

 Sequence[Segment[(a, 0), (0, a)], a, 1, 10, 0.5] 

o Creates a list of segments with distance 0.5. 
o Each segment connects a point on the x-axis with a point on the y-

axis (e.g. points (1, 0) and (0, 1); points (2, 0) and (0, 2). 
 
 

 If s is a slider with interval from 1 to 10 and increment 1, then command 
Sequence[(i, i), i, 0, s] 

o creates a list of s + 1 points whose length can be changed 
dynamically by dragging slider s. 

o Points have coordinates (0, 0), (1, 1), …, (10, 10) 

https://www.youtube.com/watch?v=-Xp7xAIV878&list=PLITakOESY-2xJ5SIit2it8Mc5Y6uO8uy8&index=5
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6. Visualizing Multiplication of Natural Numbers   

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Show the Input Bar (View menu). 

 In the Options menu set the Labeling to All 
New Objects. 

 

Construction Steps 

1 
 

Create a horizontal slider Columns for number with Interval from 1 to 
10, Increment 1 and Width 300. 

2 
 

Create a new point A. 

3 
 

Construct segment a with given length Columns from point A. 

4 
 

Move slider Columns to check the segment with given length. 

5 
 

Construct a perpendicular line b to segment a through point A. 

6 
 

Construct a perpendicular line c to segment a through point B. 

7 
 

Create a vertical slider Rows for number with Interval from 1 to 10, 
Increment 1 and Width 300. 

https://www.youtube.com/watch?v=X8-DymOP2pM&list=PLITakOESY-2xJ5SIit2it8Mc5Y6uO8uy8&index=6
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8 
 

Create a circle d with center A and given radius Rows. 

9 
 

Move slider Rows to check the circle with given radius. 

10 
 

Intersect circle d with line b to get intersection point C. 

11 
 

Create a parallel line e to segment a through intersection point C. 

12 
 

Intersect lines c and e to get intersection point D. 

13 
 

Construct a polygon ABDC. 

14 
 

Hide all lines, circle d and segment a. 

15 
 

Hide labels of segments (Stylebar). 

16 
 

Set both sliders Columns and Rows to value 10. 

17  
Create a list of vertical segments. 
Sequence[Segment[A+i*(1, 0), C+i*(1, 0)],i ,1 ,Columns] 

  

Note: 

A + i*(1, 0) specifies a series of points starting at point A with 

distance 1 from each other. 

C + i*(1, 0) specifies a series of points starting at point C with 

distance 1 from each other. 

Segment[A + i*(1, 0), C + i*(1, 0)] creates a list of 

segments between pairs of these points. Note, that the endpoints of 
the segments are not shown in the Graphics View. 
Slider Column determines the number of segments created. 

18  
Create a list of horizontal segments. 
Sequence[Segment[A+i*(0, 1), B+i*(0, 1)], i, 1, Rows] 

19 
 

Move sliders Columns and Rows to check the construction. 

20 
 

Insert static and dynamic text that state the multiplication problem 
using the values of sliders Columns and Rows as the factors: 

text1: Columns 

text2: * 

text3: Rows 

text4: = 

21  
Calculate the result of the multiplication:  
result = Columns * Rows 

22 
 

Insert dynamic text5: result 

23 
 

Hide points A, B, C and D. 

24  Enhance your construction using the Stylebar. 
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7. Challenge of the Day: String Art Based on Bézier 
Curves          

Bézier curves are parametric curves used in 
computer graphics. For example, they are used 
in order to create smooth lines of vector fonts. 
Let’s create some ‘string art’ based on Bézier 
curves. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Geometry. 

 Show the Input Bar (View menu). 

 In the Options menu set the Labeling to All New Objects. 

Construction Steps 

1 
 

Create segment a with endpoints A and B. 

2 
 

Create segment b with endpoints A and C. 

3 
 

Create a slider for number n with Interval 1 to 50, Increment 1 and 
Width 200. 

4  Create Sequence[A + i/n (B - A), i, 1, n]. 

  
Hint: This sequence creates a list of n points along segment AB with a 
distance of one nth of the length of segment a. 

5  Create Sequence[A + i/n (C - A), i, 1, n]. 

  
Hint: This sequence creates a list of n points along segment AC with a 
distance of one nth of the length of segment b. 

6 
 

Hide both lists of points. 

7  
Create a list of segments. 
Sequence[Segment[Element[list1,i],Element[list2,n+1-i]],i,l,n] 

  
Hint: These segments connect the first and last, second and last but 
one, last and first point of list1 and list2. 

8  Enhance your construction using the Stylebar. 

9 
 

Move points A, B and C to change the shape of your Bézier curve. 

10 
 

Drag slider n to change the number of segments that create the Bézier 
curve. 

 
Note: The segments you just created are tangents to a quadratic Bézier curve.  

https://www.youtube.com/watch?v=7CPuvbLiKvs&list=PLITakOESY-2xJ5SIit2it8Mc5Y6uO8uy8&index=7
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Task 

Create more ‘string art’ with GeoGebra using sequences of points and segments. 

 
 



 

 

 

 

 

Spreadsheet View and  

Basic Statistics Concepts 
 

GeoGebra Workshop Handout 9 
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1. Introduction to GeoGebra’s Spreadsheet View    

You can open the Spreadsheet View by either choosing  Spreadsheet & 

Graphics from the Perspectives sidebar or by selecting  Spreadsheet from the 
View menu.  
 

Spreadsheet Cells Input 

In GeoGebra’s Spreadsheet View every cell has a specific name that allows you 
to directly address each cell. For example, the cell in column A and row 1 is 
named A1.  
Note: These cell names can be used in expressions and commands in order to 
address the content of the corresponding cell. 
 
Into the spreadsheet cells you can enter not only numbers, but all types of 
mathematical objects that are supported by GeoGebra (e.g. coordinates of 
points, functions, commands). If possible, GeoGebra immediately displays the 
graphical representation of the object you enter into a spreadsheet cell in the 
Graphics View as well. Thereby, the name of the object matches the name of the 
spreadsheet cell used to initially create it (e.g. A5, C1). 
 
Note: By default, spreadsheet objects are classified as auxiliary objects in the 

Algebra View. Choose  Auxiliary Objects from the Algebra View’s Stylebar to 
show these objects.  
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2. Record to Spreadsheet Feature      

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Spreadsheet & Graphics. 

 Show the Input Bar (View menu). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Introduction of new feature 

 
Record to Spreadsheet New! 

Construction Steps 

1 
 

Create a slider a with default Interval and Increment 1. 

2 A = (a, 2a) Create point A by entering A = (a, 2a) into the Input Bar. 

  
Hint: The value of slider a determines the x-coordinate of 
point A while the y-coordinate is a multiple of this value. 

3 
 

Show the label of point A in the Graphics View. 

https://www.youtube.com/watch?v=XfqgdV-ku4s&index=1&list=PLITakOESY-2xhRr0IdTpwGQuvg1FWOzey


 

Introduction to GeoGebra   
 

 

 117   

4 
 

Change the value of slider a to examine different positions of 
point A. 

5  

 

Use tools Move Graphics View, as well as Zoom In and 
Zoom Out to adjust the visible part of the Graphics View and 
make point A visible in all positions. 

6  Turn on the trace of point A. 

  
Hint: Right-click (MacOS: Ctrl-click) on point A and select 
Trace On from the appearing context menu. 

7 
 

Change the value of slider a to examine the trace point A 
leaves for every slider position. 

8 
 

Set the value of slider a to -5. 

9 
 

Record the coordinates for different positions of point A to 
the spreadsheet: 

  

(1)  Right-click (MacOS: Ctrl-click) on point A and select 
 Record to Spreadsheet from the appearing context 
 menu. Choose Values of x(A), y(A), then close the 
 Record to Spreadsheet dialog. 
(2)  Now, change the value of slider a in order to record 
 the coordinates of all other possible positions of point 
 A to the spreadsheet as well. 
 Note: Do not switch to another tool before moving the 
 slider. 

Tasks  

Task 1: Examine the pattern of y-values in column B 

You could give this construction to your students and let them explore the pattern 
in column B, which is created by the y-coordinates of different positions of point 
A. Encourage your students to make a prediction about a function graph that 
runs through all different positions of point A. Have your students enter the 
corresponding function into the Input Bar in order to check if their prediction was 

correct (e.g. students enter f(x) = 2x to create a line through all points). 

Task 2: Create a new problem  

Change the y-coordinate of point A in order to create a new problem:  

 Double-click on point A in  Move mode to open the Redefine dialog.  
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 Change the y-coordinate of point A to, for example, a^2. 

 Use the Stylebar to change the color or size of point A. 

 Repeat steps 7 to 9 of the instructions above in order to record the 
coordinates of the new positions of point A to the spreadsheet.  
Note: If you didn’t delete the old values in columns A and B, GeoGebra 
automatically uses the next two empty columns (e.g. columns C and D) in 
order to record the new values for x-coordinates and y-coordinates. 

3. Relative Copy and Linear Equations     

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Spreadsheet & Graphics. 

 Show the Input Bar (View menu). 
 

 

https://www.youtube.com/watch?v=vlKqSLlWVX8&list=PLITakOESY-2xhRr0IdTpwGQuvg1FWOzey&index=2


 

Introduction to GeoGebra   
 

 

 119   

Construction Steps 

1 
 

Activate tool Move Graphics View and drag the origin of the 
coordinate system close to the lower left corner of the Graphics 
View. 

2 (0, 0) 
In the Spreadsheet View, click on cell A1 enter the point 

coordinates (0, 0).  

3 (1, 1) 
In the Spreadsheet View, click on cell A2 enter the point 

coordinates (1, 1). 

4 
 

Show the labels of both points in the Graphics View. 

5 
 

Relative copy the inserted point coordinates to other cells in 
column A:  

  

(1)  Highlight both cells A1 and A2 by using the mouse.  
(2)  Click on the little square at the lower right corner of the 
 highlighted cell range.  
(3)  Hold the mouse button down and drag the pointer down 
 to cell A11. 

6  

 

Use tools Move Graphics View, as well as Zoom In and Zoom 
Out to adjust the visible part of the Graphics View and make all 
points visible. 

Tasks 

Task 1: Examine the coordinates of the point sequence 

What sequence of numbers is created if you apply the ‘relative copy’ feature of 
the Spreadsheet View the way it is described above? 
Hint: Examine the x-coordinates of all created points and come up with a 
conjecture about how they are related. Then, check your conjecture using the y-
coordinates of the points. 

Task 2: Find the matching equation 

Make a prediction about an equation that would create a graph going through all 
points of this sequence. Enter this equation into the Input Bar in order to check 
your prediction. 

Task 3: Create a new problem 

Change the coordinates of the initial points in order to create a sequence of 
points that can be examined by your students. 
Version 1: Change the initial points in the Spreadsheet View 
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Double-click in cell A2 and change the coordinates of the corresponding point to 

(1, 2). After hitting the Enter-key, all points that depend on point A2 

automatically adapt to this change, both in the Spreadsheet View as well as in 
the Graphics View. 
 
Version 2: Change the initial points in the Graphics View 

Activate tool  Move and drag point A2 to a different position in the coordinate 
system. Immediately, all dependent points dynamically adapt to these changes 
both in the Graphics View as well as in the Spreadsheet View. 
Note: In order to restrict the coordinates of the points to be integers, you can 

change the  Point Capturing to Fixed on Grid. Show the  Grid using the 
Stylebar. 
 
Hint: By changing the coordinates of point A1 as well you are able to create 
problems that result in linear equations of the form y = m x + b which do not run 
through the origin of the coordinate system. 

4. Investigating Number Patterns       

Let’s investigate how the surface of a cube changes depending on the length of 
its edges. 

Preparations with Paper and Pencil 

Calculate the surface of a cube for the given length e of its edges. Pick at least 
two edge lengths from each table but do not pick the same numbers as your 
neighbor. 
 

 
 

https://www.youtube.com/watch?v=wtrDqagiRV8&index=3&list=PLITakOESY-2xhRr0IdTpwGQuvg1FWOzey
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Preparations in GeoGebra 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Spreadsheet & Graphics. 

 Show the Input Bar (View menu). 

 In the Options menu set the Labeling to New Points Only. 
 

 

Construction Steps 

Create a Scatter Plot from your Data 

1  
Enter the following numbers into the spreadsheet cells of column A: 

A1:  1  A2: 2 

2  
Highlight cells A1 and A2. Relative copy the values to cell A10 in 
order to create a sequence of different edge lengths. 

  Hint: This creates the integers from 1 to 10. 

3  
In cell B1, enter the surface formula with reference to the edge length 
of the cube in cell A1. 

  
Hint: After entering the equal sign, you can click on cell A1 to enter 
its name into the active cell B1. 
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4  Select cell B1 and relative copy the formula down to cell B10. 

5  Create a Scatter Plot from this data: 

  

(1)  Use the mouse to highlight all cells of columns A and B that 
 contain numbers. 
(2)  Right-click (MacOS: Ctrl-click) on one of the highlighted cells 
 and select Create List of Points from the appearing context 
 menu. 

  
Note: The values in column A determine the x-coordinates and the 
values in column B specify the y-coordinates of the plotted points. 

  
Hint: The points created from the data are displayed in the Algebra 
View as a list of points. By default, GeoGebra calls this list L1. 

6 
 

Use tool Move Graphics View in order to change the scale of the  
y-axis so that all points are visible in the Graphics View. 

  
Hint: Select tool Move Graphics View. Click on the y-axis and drag it 
down until you can see the 600 tick mark. 

Investigate the Number Pattern in Column B 

7  
In cell C2, enter the formula =B2-B1 to compute the difference of the 

two successive surface values. 

8  Select cell C2 and relative copy the formula down to cell C10. 

9  
In cell D3, enter the formula =C3-C2 to compute the difference of the 

two successive differences. 

10  Select cell D3 and relative copy the formula down to cell D10. 

Task 1 

Examine the number sequences in columns C and D. Make a conjecture about 
the polynomial function that runs through all points plotted in the Graphics View 
and allows you to compute the surface of a cube for any given edge length e. 

 Is it possible to determine the degree of this polynomial by investigating 
the sequences of differences you generated in columns C and D? 

 Explain to your neighbor why we were repeatedly calculating differences 
of successive values and what they actually mean. 

 Is it possible to determine the coefficient of the polynomial by investigating 
the sequences of differences you generated in columns C and D? 

 Would this also work if the values in column A are not successive integers 
(e.g. 1, 3, 5,…)? Give a reason for your answer. 
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Check your Conjecture about the Polynomial 

11 
 

Create a slider n with Interval from 0 to 5 and Increment 1. Change 
the orientation of the slider from Horizontal to Vertical (Tab Slider). 

12 
 

Create a slider a with Interval from 0 to 10 and Increment 1. Change 
the orientation of the slider from Horizontal to Vertical (Tab Slider). 

13  
Enter the polynomial f(x) = a * x^n in order to create a 

polynomial of degree n with coefficient a. 

  
Note: Both the degree n as well as the coefficient a can be changed 
by using the corresponding sliders. 

14 
 

Change the values of sliders a and n to match your conjecture. Does 
the polynomial run through all points plotted in the Graphics View? 

Enhance your Construction 

15 
 

Insert the polynomial’s equation as a dynamic text in the Graphics 
view. 

  

Hint: Select tool Text and click on the Graphics View to open the text 
edit dialog window. 

(1)  Enter f(x) = into the text edit dialog window. 

(2)  Click on the graph of the polynomial to insert it’s name into the  
       text edit dialog window.  
       Note: GeoGebra will enter the syntax necessary for dynamic 
 text automatically. 
(3)  Click on the OK button. 

16 
 

Insert a checkbox that allows you to show/hide the polynomial’s 
equation. 

  

Hint: Select tool Check Box and click on the Graphics View to open 
the checkbox dialog window. 

(1)  Enter the caption Show equation. 

(2)  Click on the little arrow to open list of available objects.  
(3)  Select text1 from this list and click the Apply button. 

17 
 

Activate the Move tool and try out if your checkbox controls the 
visibility of the text. 

18 
 

Open the Properties dialog and enhance the layout of the objects in 
the Graphics View (e.g. change the color of the polynomial and 
points, match the color of the text with the color of the polynomial, fix 
the position of the slider, checkbox and text in the Graphics View).   
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Task 2 

 Try if this concept of investigating sequences of differences of two 
successive function values works for all polynomials f(x) = a xn.  
Hint: You can enter a formula into cell B1 and relative copy it down to cell 
B10 in order to create a list of function values. Don’t forget to start the 

formula with an equal sign (e.g. = x^2). 

 What modifications in the Spreadsheet View and Graphics view are 
necessary to be able to easily determine the constant of polynomials  
f(x) = a xn + b? 

5. Scatter Plot and Best Fit Line       

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  Spreadsheet & Graphics. 

 Show the Input Bar (View menu). 

 In the Options menu set the Labeling to New Points Only. 
 

 
 

https://www.youtube.com/watch?v=BEhhdLqBd_M&list=PLITakOESY-2xhRr0IdTpwGQuvg1FWOzey&index=4
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Introduction of new tool 

 
Best Fit Line  New! 

Construction Steps 

1  
Enter the following numbers into the spreadsheet cells of column A: 

A1:  1  A2: 5 A3:  2 A4:  8 A5: -2 

2  
Enter the following numbers into the spreadsheet cells of column B: 

B1:  -1  B2:  2  B3:  3 B4:  4 B5:  1 

3  Create a Scatter Plot from this data: 

  

(1)  Use the mouse to highlight all cells of columns A and B that 
 contain numbers. 
(2)  Right-click (MacOS: Ctrl-click) on one of the highlighted cells 
 and select Create List of Points from the appearing context 
 menu. 

  
Note: The values in column A determine the x-coordinates and the 
values in column B specify the y-coordinates of the plotted points. 

4 
 

Use tool Best Fit Line in order to create the line that best fits your 
data points. 

  

Hint: Activate tool Best Fit Line and select all data points using a 
selection rectangle: Click in the upper left corner of the Graphics 
View. Hold the mouse key down while moving the pointer to the 
lower right corner of the Graphics View in order to specify the 
selection rectangle. 

5  Change color and thickness of the line using the Stylebar. 

6  
Using this construction you can easily demonstrate how outliers 
impact the best fit line of a data set: 

 
 

Drag one of the points with the mouse and explore how this 
modification influences the best fit line. 

  Hint: You can also change the initial data in the Spreadsheet View. 

Importing Data from other Spreadsheets 

Note: GeoGebra allows you to copy and paste data from other spreadsheet 
software into the GeoGebra spreadsheet: 

 Select and copy the data you want to import (e.g. use the keyboard 
shortcut Ctrl-C (MacOS: Cmd-C) in order to copy the data to your 
computer’s clipboard).  
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 Open a GeoGebra window and show the Spreadsheet View. 

 Click on the spreadsheet cell that should contain the first data value. 

 Paste the data from your computer’s clipboard into GeoGebra’s 
Spreadsheet View (e.g. use the shortcut Ctrl-V (MacOS: Cmd-V) or right-

click (MacOS: Ctrl-click) on the highlighted cell and select  Paste). 

6. Challenge of the Day:   
Explore Basic Statistics Commands  

Yesterday, you gave a mathematics quiz to the 25 students of your 1st period 
math class. After the quiz, you asked your students to rate the difficulty of the 
quiz on a scale from 1 (‘very easy’) to 5 (‘very difficult’).  

 4 of your students rated the quiz ‘very easy’ (1)  

 6 students rated the quiz ‘easy’ (2) 

 6 other students rated the quiz ‘difficult’ (4)  

 1 student rated the quiz ‘very difficult’ (5) 

 The rest of the students thought the difficulty of the quiz was ‘ok’ (3). 

Task 1: Create a histogram 

Enter the data into GeoGebra’s Spreadsheet View and create a histogram that 
visualizes this data.  
Hints: 

 If you don’t know how to use command Histogram, enter the command 
into the Input Bar and press the F1 key. 
Note: Class boundaries determine the position and width of the bars of the 
histogram. The absolute number of students that rated the difficulty of the 
quiz for each item determines the height of the histogram bars.  

 Choose the class boundaries so that the actual rating score is displayed in 
the middle of each histogram bar. 

 You need to create a list of the data in each column before you can use 
the Histogram command  
Note: Highlight all numbers in one column and right-click (MacOS: Ctrl-
click) on one of the highlighted cells. Select Create List from the appearing 
context menu. 

Task 2: Determine mean, median and mode 

1. Make a prediction for mean, median and mode of the data you collected. 
Hint: You can use command Sort in order to sort the list of frequencies of 
students who rated the difficulty of the quiz in each category. 

2. Check your prediction using the commands Mean, Median and Mode. 
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Introduction to GeoGebra   
 

 

 128   

 

 

 

 

 

CAS View – Computer 

Algebra System & CAS 

Specific Commands 
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1. Introduction to GeoGebra’s CAS View      

The CAS View allows you to use GeoGebra's CAS (Computer Algebra System) 
for symbolic computations. The view consists of rows, each of them has an input 
field at the top and an output display at the bottom. 

You can open the CAS View by either choosing  CAS & Graphics from the 

Perspective Sidebar or by selecting  CAS from the View menu. 
 

 

Input in CAS View 

In the GeoGebra’s CAS View use the equal sign to enter an equation. The CAS 
toolbar offers three different tools to evaluate your input with: 

  “Evaluate” calculates and simplifies the input in a symbolic way, 

  “Numeric” calculates the input numerically and yields the result in 
decimal notation and 

  “Keep Input” keeps and checks the input. 
 

“Keep Input” is very useful if you don’t want your input to be simplified 
automatically, for example introducing the manipulation of expressions. Further 
more, by selecting a part of your input, you can apply a tool to this part only. 
You can use the input fields the same way you would use the Input Bar, with 
following differences: 

http://wiki.geogebra.org/en/Input_Bar
https://www.youtube.com/watch?v=UompgbgKZ4k&list=PLITakOESY-2ywKVrgEvBI-H3hmKUXxcsf&index=2
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 You can use variables that were not assigned any value. For example 

(a + b)^2 evaluates to a^2 + 2ab + b^2 if a and b are free 

variables. 

 “=” is used for equations and “:=” for assignments. Therefore c = 2 is an 

equation and c := 2 assigns the value 2 to c. 

Several tools from GeoGebra’s CAS View 

 
Evaluate   New! 

 
Substitute   New! 

 
Numeric   New! 

 
Solve    New! 

 
Keep Input   New! 

 
Solve Numerically  New! 

 
Factor    New! 

 
Derivative   New! 

 
Expand   New! 

 
Integral   New! 

Basic Input 

 Enter: Evaluate the input symbolically, e.g. 3/4 a – 1/4 a yields 1/2 a. 

 Ctrl - Enter: Evaluate the input numerically, e.g. 3/4 yields 0.75. 

 Alt - Enter: Check the input but do no evaluate, e.g. b + b remains b + b. 

Note that assignments work regardless of the tool choosen, in explicit: 
Keep Input does assign the right hand side to the label, variable or function 
name provided, though not evaluating the assigned input. 

 In an empty row type: 
o Space bar for previous output 
o ) for previous output in parentheses 
o = for previous input 

 Suppress output with a semicolon at the end of your input, e.g. a := 5; 

 
You can refer other rows in the CAS View in two ways: 

 Static row references copy the output and won't be updated if the referenced 
row is subsequently changed 

 # copies the previous output 

 #5 copies the output of row 5 

 Dynamic row references insert a reference to another row instead of the 
actual output and therefore will be updated if the referenced row is 
subsequently changed 

 $ inserts a reference to the previous output 

 $5 inserts a reference to the output of row 5 
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2. Manipulating Equations         

Manipulating terms and equations are important topics in lower grade secondary 
school. In this example you will learn how to achieve this in the CAS View. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  CAS & Graphics. 

Introduction of New Tools 
 

 
Evaluate   New! 

 
Numeric   New! 

 
Keep Input   New! 

Construction Steps 

Finishing your construction, the CAS View will look like this: 

 

 
  

https://www.youtube.com/watch?v=3LxvEYVo_yQ&list=PLITakOESY-2ywKVrgEvBI-H3hmKUXxcsf&index=2
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1 
 

Enter the equation (2x - 1) / 2 = 2x + 3 into the first row. 

Use the Keep Input tool to prevent automatic simplification. 

2 
 

Type ) in the second row to copy the output of the first row and 

automatically put parentheses around it. Then type + 1/2 to add 

one half to both sides of the equation. Again apply the Keep Input 
tool. 

3 
 

Press the space key to copy the previous output into the third row. 
Use the Evaluate tool to calculate the result symbolically, in explicit 
yielding the rational number as a fraction. 

4 
 

Click onto the output of the second row to copy it to the currently 
selected row four. Applying the Numeric tool computes the result 
numerically, the rational number is given in decimal notation. 

 
Hint: There are further ways of solving equations in the CAS View, for example 
using the commands Solve and NSolve or their respective tools. Please find 
more information in the manual: http://help.geogebra.org. 
 
Challenge: Think about the pros and cons of using CAS View to solve equations 
in school. 

3. GCD and LCM          

In school the greatest common divisor (GCD) and the least common multiple 
(LCM) of two or more numbers are usually calculated by factoring the numbers 
involved. The product of all occurring prime factors to certain powers then results 
in the GCD and the LCM. For each prime factor: 

 Choose the minimum of the powers it has in the involved numbers to 
obtain the GCD. 

 Choose the maximum of the powers it has in the involved numbers to 
obtain the LCM. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  CAS & Graphics. 

Introduction of New Tool 

 
Factor    New! 

 

http://help.geogebra.org/
https://www.youtube.com/watch?v=oNXratXAyrk&list=PLITakOESY-2ywKVrgEvBI-H3hmKUXxcsf&index=3
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Construction Steps 

Finishing your construction, the CAS View will look like this: 
 

 
 

1 
 

Choose and enter an arbitrary number, for example 240 and click the 

Factor tool. 

2 
 

Choose and enter another arbitrary number, for example 160. Again 

apply the Factor tool. 

3  

Calculate the GCD of both numbers by multiplying the common 
prime factors to the minimum power occurring in the products: 
2^4 * 5^1 

Hint: Use “^“ to denote “to the power of”. 

4  
Calculate the LCM of both numbers by multiplying the prime factors 
to the maximum power occurring in the products: 
2^5 * 3^1 * 5^1 

5  
Use the command GCD to compute the greatest common divisor of 

both numbers automatically: Enter and evaluate GCD[240, 160] 

6  
Achieve the same for the lowest common multiple by entering and 

evaluating LCM[240, 160] 
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Challenge: The CAS View can be used to calculate the GCD and LCM of 
arbitrary polynomials in exactly the same way as with numbers. Go ahead and 

compute the GCD and LCM of a x^2 – 2 a b x + a b^2 and x^2 - b^2 

in both ways employed above! 
 
Hint: Make sure neither a nor b have been assigned a value previously. Open a 
new window if you are not sure. The solutions are x - b and 
a x³ - a b x² - a b² x + a b³, respectively. 

Back to School … 

(a) Since factoring of large numbers is not feasible in general, another 
algorithm is applied frequently: the Euclidean Algorithm. Recall or look up 
how and why it works. Which approach do you prefer? 

(b) Think about the pros and cons calculating GCD and LCM with and without 
electronic means, like GeoGebra, in school. 

4. Intersecting Polynomial Functions      

Intersect the parabola f(x) := (2 x^2 – 3 x + 4) / 2 with the line 
g(x) := x / 2 + 2 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  CAS & Graphics.  

Introduction of New Tool 

 
Solve    New! 

 
  

https://www.youtube.com/watch?v=yOy5yHmBqwE&list=PLITakOESY-2ywKVrgEvBI-H3hmKUXxcsf&index=4


 

Introduction to GeoGebra   
 

 

 135   

Construction Steps 

Finishing your construction, GeoGebra will look like this: 
 

 
 

1  
Define the function f as f(x) := (2 x^2 – 3 x + 4) / 2 

Hint: Use “:=” for definitions and “=” for equations. 

2  Define the function g as g(x) := x / 2 + 2 

3  Define the function h as h(x) := f(x) - g(x) 

4 
 

Enter h(x) into the fourth row and apply the tool Factor. You can 

immediately read off the roots of h. 

5 
 

Enter h(x) = 0 and apply the Solve tool to obtain the x-coordinates 

of the intersection points. 

6  
Calculate the intersection points by using the command Intersect: 
S := Intersect[f(x), g(x)] 

7  
Adjust color, line thickness and style of the objects in the 
Graphics View. 
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Hint: Like functions defined via the Input Bar, functions defined in the CAS View 
are automatically drawn in the Graphics View. Moreover, color changes in any 
other view affect the CAS View as well, thereby emphasizing the connection 
between the different representations of the same object in different views. 
 
Challenge: Explain why the roots of h correspond to the intersection points of f 
and g. 
 
Challenge: In the course of the above construction you have already solved the 
problem of intersecting the two polynomial functions f and g in three different 
ways. Find another! 

Back to School … 

(a) In general, different formulas can describe the same function. Decide 
whether this is the case here! 
If yes, choose an appropriate tool from the CAS Toolbar and show the 
equality. If no, give an argument mapping to two different images! 

i.                              

ii.                              

iii.                         

(b) Consider the function           . 
i. For which arguments is       ? 
ii.            holds for all arguments t. Why? 

5. Solving Exponential Equations      

Chess & Grains 

For many centuries chess has been a game well known and popular. Its very 
creation is surrounded by different variants of the following legend: 
Once upon a time an Indian ruler led his country and citizens into poverty and 
misery. A wise man intended to call the ruler’s attention to his failures, yet feared 
his wrath. So he devised the game chess: While in chess the king is the most 
important piece beyond doubt, it is utterly helpless without the other piece. Even 
pawns play a crucial role. 
Getting to know chess the Indian ruler understood the message and became 
more gentle and gracious. Highly impressed he offered the wise man a reward of 
his choice. When the wise man asked for one grain for the first square, two for 
the second, four for the third, and so on, the ruler thought this a modest and 
humble wish and granted it gladly. 
 
How many grains are there on square number five? 
Which square are 1024 grains on? 

https://www.youtube.com/watch?v=g_OSSoqqZXA&index=5&list=PLITakOESY-2ywKVrgEvBI-H3hmKUXxcsf
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Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  CAS & Graphics. 

Introduction of New Tool 

 
Solve Numerically  New! 

Construction Steps 

Finishing your construction, the CAS View will look like this: 
 

 
 

 

1  
Define the function f as f(n) := 2^n. 

Hint: Use “:=” for definitions and “=” for equations. 

2  Calculate the number of grains at the fifth piece as f(5). 

3 
 

Enter 1024 = f(n). Now find a n satisfying this equation by 

applying the Solve tool. 
Hint: You could also use the Solve command instead: 

Solve[1024 = f(n)]. 

4 
 

Alternatively, employ the Solve Numerically tool to solve numerically. 
Hint: You could also use the NSolve command instead: 

NSolve[1024 = f(n)]. 
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Hint: Specify the variable to solve for by adding it as second argument, for 

example Solve[1024 = f(n), n] This works both with the Solve and the 

NSolve command! 
 

Challenge: Define the function g as g(t) := c * a^t Use the commands 

Solve and NSolve to 
a) find t such that g(t) = c / a, 
b) find c such that g(2) = 225 and 
c) find a such that g(2) = 255. 

6. Solving Systems of Equations       

In this section you learn how to solve systems of equations with just one click, 
including non-linear equations and derivatives. Let’s find a polynomial function of 
degree three featuring the saddle point (1,1) as well as the point (2,2). 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  CAS & Graphics. 

Construction Steps 

Finishing your construction, GeoGebra will look like this: 
 

 
 

https://www.youtube.com/watch?v=nF3wjonhNp8&list=PLITakOESY-2ywKVrgEvBI-H3hmKUXxcsf&index=6
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1  Define the function f(x) := a x^3 + b x^2 + c x + d 

2  

The function value at 1 is 1: g_1: f(1) = 1; 

Hint: Use “:” to name your equation. The semicolon “;” suppresses 

the output. 

3  The function value at 2 is 2: g_2: f(2) = 2; 

4  
The first derivative vanishes at 1: g_3: f'(1) = 0; 

Hint: The derivative of f can be written as f prime “f'”. 

5  The second derivative vanishes at 1: g_4: f''(1) = 0; 

6 
 

Select rows two through five and apply the Solve tool. 
Hint: Press and hold the CTRL-key while clicking onto the row 
headers to select several rows concurrently. 
Hint: You can achieve the very same employing the Solve command: 
Solve[{g_1, g_2, g_3, g_4}, {a, b, c, d}] 

7  

Substitute the undefined variables in the formula of f to draw the 
function. To do so, drag the output of row six onto the definition of f in 
row one. 
Hint: To drag an object, click onto it, hold the mouse button down 
and move the cursor to the target location ahead of releasing it 
again. 

8 
 

Turn on the visibility of the function in the new row. 

 
Hint: You can also calculate the derivative of a function or term applying the 
Derivative tool. To integrate a function or term, deploy the Integral command or 
tool. Go ahead and try them out right now! 
 

Challenge: In the last step you could also enter and evaluate f(x) in a new row 

and drag the result from row six there. Other ways to substitute undefined 
variables are the Substitute command and the Substitute tool. Employ all three 
methods to draw f!  
 
Challenge: You have come up with and drawn a solution. Is this solution unique? 

7. Working with Matrices        

Matrices are an important tool in mathematics and employed in various areas. 
Examples include the short and concise denotation of systems of linear 
equations as well as solving of the beforementioned. In this section you will learn 
how to unleash the power of matrix calculus in the CAS View. 
 
 
 
An arbitrary fully determined system of independent linear equations, for example 

https://www.youtube.com/watch?v=-_ebvPLEa0s&list=PLITakOESY-2ywKVrgEvBI-H3hmKUXxcsf&index=7
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can be written as a matrix multiplication, namely 
 

(
   
   
    

)
⏟        

 

 (
 
 
 
)

⏟
 

 (
 
 
 
)

⏟
 

   

 
In general, this permits us to consider the simple problem of solving the single 
matrix equation A * X = B instead. This in turn can be achieved by multiplying 
with the inverse matrix of A from the left. 

Preparations 

 Open a new GeoGebra window. 

 Switch to Perspectives –  CAS & Graphics. 

Construction Steps 

Finishing your construction, the CAS View will look like this: 
 

 
 

 

1  
Enter the coefficient matrix A as  
A := {{2, 3, 2}, {1, 1, 1}, {0, -1, 3}} 
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2  Define the column vector B as B := {{3}, {2}, {7}} 

3  Calculate the result via Invert[A] * B 

 
Hint: Matrices are entered as a list of their rows from top to bottom. The rows 
themselves are provided as lists containing the actual values from left to right. 

Therefore the matrix (
  
  

) is given as {{a, b}, {c, d}}. 

Challenge 

Solve the following system of equations using matrices in the CAS View: 
 

        

 √       
 


